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About Datgel CPT Tool 2 
The Datgel CPT Tool gINT Add-In 2 is designed streamline the processing and interpretation of Cone 
Penetration Test and Dissipation Test data: 

 Designed for flexibility and user configuration 

 ASCII data files in numerous standard and propriety formats may be imported 

 Filter rod changes 

 Calculate derived parameters 

 The soil type and strength may be interpreted based on user defined parameters, and then a 
summary can be transferred to your soil description and consistency/density table 

 More than 60 preconfigured published correlations are calculated, written to the database and 
ready for presentation on your graphs and logs 

 User-definable correlation formulas 

 Dissipation test analysis 

 More than 100 customisable log, graph and fence reports 

 User definable line colours, types and scales 

 Our CPT processing code has been used to manage tens of thousands of tests by clients 
across the globe 

You need to complete the installation procedure (see Installation and Licensing on page 1) and activate 
(see Datgel Product Licensing System User Guide) before you can use the CPT Tool. 

New in Version 2 

1. More than 60 preconfigured correlations  

2. Formula Tool for user-definable correlation formulas 

3. Dynamic user definable log, fence and graph reports 

4. User definable line colours, types and scales 

5. Schneider, Randolph, Mayne and Ramsey (2008) soil behaviour type interpretation 

6. Dissipation test analysis 

7. Import of more data file formats: Vertek (*.dat), Pagani (*.cpt), Geomil PlotCPT (*.T*) 

8. Seismic cone 

Support 

12 months support and maintenance is included with the license purchase.  For technical support 
please email support@datgel.com or call +61 2 8202 8600. 

System Requirements 

gINT 

The product runs optimally using gINT 8.2.008 or higher, however it will run using gINT 8.1.2.008 or 
higher. 

mailto:support@datgel.com
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gINT Professional is recommended.  The product will run using gINT Logs, gINT Logs Plus, and gINT 
Professional.  However the tool includes graph and fence reports that can only be used with gINT 
Professional. 

Hardware and Operating System 

Same system requirements as gINT 8.2, see: http://www.gintsoftware.com/products_requirements.html. 

Required Windows Components 

1. Windows Installer 3.1 

2. .NET 3.5 Framework SP1 

Conventions and typography used in this guide 

Note: Tips and additional Information to help you. 

> Used to indicate a series of menu commands. 

e.g. Select File > Open.  

| Used to indicate a gINT Application Group, Application, Table Group or Table , e.g. 
DATA DESIGN | Project Database 

Bold Text Items you must select, command buttons, or items in a list. 

e.g. Navigate to UTILITIES | Convert Projects (4
th

 tab). 

Italics Emphasis Use to emphasize the importance of a point such as parameters. 

e.g. Data Entry – Check Omit Must Save prompt when save is required 

CAPITALS Names of keys on the keyboard. for example, SHIFT, CTRL, or ALT. 

KEY+KEY Key combinations, for example CTRL+P, or ALT+F4. 

Code Snippet Indicates a code snippet within a paragraph 

Code sample Indicates a sample program codes inserted in user guide e.g. 

public override string ToString () 

File name or path Used for formatting file name and paths e.g. di_lib.glb or  

V:\10 gINT\Datgel Install Files\ 

Table_Name Database table name, e.g. POINT_TABLE. 

Field_Name Database field name; e.g. PointID 

Command line Command line, presented exactly as it must be entered e.g. 

cdir 

Field Colours 

Each of the fields in the project tables have been coloured to improve the data entry process as 
indicated below in Table 1. 

http://www.gintsoftware.com/products_requirements.html
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Table 1 - Field Colours  

Field Colour Field Name and Explanation 

 Yellow gINT Key Field – mandatory data entry 

 Pastel Purple 
AGS Data – data associated with the AGS Data 
Interchange format 

 Pastel Green 
Calculated Field – data is written to this field by Datgel‟s 
code 

 Pastel Beige 
Data Entry Field – data should be entered into this field, 
or data in this field influences the calculation 

 Pastel Red 
Legacy Data Field – historic data entered here, is from 
typically an old database 

 Pastel Blue 
Output Option – used to control how the data displayed 
on a report 

 Pastel Orange 
Remark or Metadata Field – additional data associated 
with the primary information 

 Grey Read-only 

 

Note: The Datgel CPT Tool is built in two versions – DGD with long table (e.g. CPT_POINT_PARAMETERS) and 
field names and AGS RTA with short AGS-compliant names (e.g. STCS). 

Both names are usually given, although only one is relevant to any given site. Screen images are not 
duplicated and usually show only the DGD version. 
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1 Installation and Licensing 
There are four parts to the installation process: 

 DLL program installation 

 Merge gINT library objects 

 Merging project tables and fields 

 Configure settings in library and project/data template 

 Activate the product license 

The first three steps can be completed in any order and are described below. The activation procedure 
must be done last and is described in the Datgel Product Licensing System User Guide. 

1.1 DLL Program Installation 

The CPT Tool requires that the Microsoft .net 3.5 framework is installed on the PC prior to the 
installation of the CPT Tool.  If your PC does not have the .net 3.5 framework SP1 installed, then it will 
be automatically installed during the CPT Tool installation process.  You need local administrator rights 
to the PC to install the CPT Tool.  

To install the CPT Tool: 

 Ensure that gINT is closed 

 Run the setup.exe file 

 Follow the prompts 

In the following screen, you can either accept the default location for the new file, or change it by 
clicking Browse. The Disk Cost button shows the space required versus space available on each of 
your disks.  
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1.2 Which Database Structure? – DGD or AGS RTA 

At this point you must decide which CPT Tool database structure to use.  The options are: 

1. DGD (stands for Datgel Database) with long table (e.g. CPT_POINT_PARAMETERS) and field 
names. 

2. AGS RTA, based on the structure prescribed by the Roads and Traffic Authority of NSW, 
Australia, and the Association of Geotechnical and Geoenvironmental Specialists.   The 
database has short AGS-compliant names (e.g. STCS). 

Unless you‟re currently using an AGS RTA style database, we recommend you adopt the DGD 
database. 

1.3 Merge gINT Library Objects 

Note: If you‟re in one of the following situations then proceed to Section 1.6 Validate or Activate License. 

In the trial version of the CPT Tool, the library will be locked and you cannot merge any gINT Library Objects 
into your Library file, or make changes to this Library file.  In this case, you have to use the locked library as-
is.   

Steps 1.3 to 1.5 have been done by Datgel‟s developers or done previously by you or a colleague. 

If you don‟t have existing gINT files then you may wish to just use the example CPT Tool gINT Files provided 
on the DVD. 

If you have purchased the CPT Tool, then you have full access to the library objects, and you may 
proceed with the following steps to merge the gINT Library components into your Library file.  

1. Make a backup copy of your existing library file. By default this is located at: 

C:\Program Files\gINT8\libraries\ 

2. Start gINT and open the library and project file you wish to use the Datgel CPT Tool with. 

3. Select UTILITIES | Lib Merge/Copy. 

4. Browse the Source Library File for datgel cpt tool dgd lib #.##.glb 

5. Check the Query On Overwrite box, then move all source tables, except Material Composite 
Symbols and Titles, to the yellow box on the right side by clicking the >> button. 
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6. Click Execute.  The process may take several minutes. 

This merges the CPT Tool Add-In menu item, gINT Rules modules, user system data and other library 
tables relevant for the use of the CPT Tool. 

Depending on which page sizes you tend to use, you may find it convenient to not merge the Letter 
(LET) and 11x17 or the A4 and A3 reports. 

1.4 Merge gINT Project File Tables and Fields 

1. Open your existing project/data template in DATA DESIGN | Project Database. 

 

2. Select Tables > Import Multiple Tables...  then browse for either file datgel cpt tool 

dgd #.##.gpj or datgel cpt tool dgd #.##.gdt.   

3. At the minimum, select the following tables to import, and click OK. 

 

The other tables are not critical to the operation of the CPT Tool and you may already have 
similar tables in your project file. However many of the gINT reports provided with the CPT 
Tool reference the other tables, and you may need to update the field references in the reports 
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to work with your custom project database.  In particular you need to consider fields on the 
POINT and PROJECT tables. 

The DATA DESIGN | Project Database | Tools > Compare Databases function will list the 
table, field, and property differences between databases.  Use this to compare your company‟s 
project file to the CPT Tool project file. 

The DATA DESIGN | Project Database | Tools > Replace Field Names function will assist 
you to update the CPT library objects to use the fields and tables in your custom project file. 

4. In DATA DESIGN | Project Database change the yellow object selector list to the POINT table, 
call the command Tables > Properties... move to the gINT Rules tab, and place Datgel Cpt 
Tool!OnSave in the gINT Rules Procedure on Save text box. 

 

5. Move to INPUT, and run the Add-Ins > Datgel Administrator Tools > Lookup List Check 
Tool to search for broken lookup list references, and rectify as needed. 

1.5 Initial Configuration 

Following the library and project merge steps, the following items should be configured: 

1. Configure the Graphic_1 and Graphic_2 fields on DG_CPT_SOIL_CLASS_ZONES library table; see 
4.10 DG_CPT_SOIL_CLASS_ZONES on page 19.  Select the most appropriate graphics in 
your library for each soil type zone. 

2. Configure the table and field names for Lithology/Stratigraphy and Consistency/Density as 
described in 14.3 Configuration of description and consistency summary transfer on page 84 . 

3. In SYMBOL DESIGN | Bitmap Symbols, import your company logo into the existing symbol 
called LOGO.  This symbol is referenced by all the Tools reports.   

Alternatively you can adjust the DRAWINGS | Drawing Library DG COM LOGO to reference 
a different Bitmap Symbols. 

Review how your logo appears on the DRAWINGS | Drawing Library block DG COM FIGURE 
TITLE BLOCK.  If required change the block x and y offset. 

4. Update the import correspondence files (*.gci) for the numerous CPT formats to work with your 
custom gINT project file. 

5. Assign correct page sizes and printer to reports.  In order to export a report to pdf or other 
image format the correct page size must be assigned. 

a) Ensure a printer driver installed on your pc has A3 and 11x17 size. 
a) Use the command REPORT DESIGN | File > Set printer for reports, pick the printer with 

A3 from the printer list, and select the A3 size reports from the reports list. 
b) Then go to each A3 and 11x17 size report in REPORT DESIGN by changing the yellow 

drop down list.  Display the report properties, File > Page > Properties, and set the page 
size to A3 or 11x17. You may also need to adjust the margins. Click Ok. 

c) Review the page margins and outlines by clicking on Zoom Page, and move to the next 
report. 
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1.6 Validate or Activate License 

After installation (and before using the CPT Tool Add-in), validate or activate the user license as 
described in Chapter 2 of the Datgel Product Licensing System User Guide. 
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2 Quick Start Tutorial 

2.1 Introduction 

This tutorial will introduce you to the basic operations of the CPT Tool; it assumes you have a basic 
understanding of gINT INPUT and OUTPUT.  If this is the first time you‟ve used gINT then we suggest 

you read the welcome_to_gint_8.pdf located in this directory C:\Program Files\gINT8\docs 

and also available from this web page http://www.gintsoftware.com/support_doc.html. 

2.2 Preliminaries 

1. First work your way though section 1 Installation and Licensing. 

2. Start gINT 8, and check you‟re running 8.2.008 or 8.1.2.008 or later by reviewing the version 
number on the Help > About gINT dialog.  If you‟re running an older update, then you should 
download and install the latest gINT update using Help > Check for gINT Update or manually 
downloading the update from http://www.gintsoftware.com/support_updates_v8.html. 

3. This tutorial will use our standard DGD CPT Tool gINT Files, located on the DVD in folder 

gINT Files\DGD\.  If you haven‟t done so, copy the folders on the DVD to a location on your 

local or network drives.  You can also use a set of custom gINT files that already have the CPT 
Tool tables and objects merged in, as described in section 1 Installation and Licensing. 

4. Now, open the datgel cpt tool dgd lib X.XX.glb, using File > Change Library. 

5. Create a new project, select the command File > New Project > Clone Data Template..., and 

select the datgel cpt tool dgd X.XX.gdt file, and click Open.  Then provide the name 

Tutorial 1.gpj and click Save. 

2.3 Importing CPT and Dissipation Data 

1. Launch the Data Import Tool, by calling the command Add-Ins > Datgel CPT Tool > Data 
Import. 

 

The CPT Tool splash screen should now appear, signifying you are now using the CPT Tool 
license.   

 If you‟re using a trial license then a form will appear telling you how many uses are left.   

 If nothing happens, then double check you have installed the CPT Tool program by 

running the setup.exe file located in the Installation Files folder on the DVD. 

 If you haven‟t previously validated your license, i.e. by entering the serial number, license 
number, contact details, and server name in the case of a network license.  Then you will 

http://www.gintsoftware.com/support_doc.html
http://www.gintsoftware.com/support_updates_v8.html
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be prompted to do so now, and you should refer to Chapter 2 of the Datgel Product 

Licensing System User Guide, which was included on the DVD in the Documentation 

folder. 
 

You should now see the Data Import Tool form. 

 

2. In this tutorial we will import a GEF files.  

a) Set File Type to GEF 1.1.0 (*.gef) 
b) Set Overwrite Option to Never 

c) Correspondence File to …\datgel_cpt_tool_dgd_X.XX_gef_cpt XX.gci.  The gci 

can be found in the gINT Files\DGD\ folder on the DVD.  The gci file translates the data 

during the import process between a temporary CSV file created by the CPT Tool code and 
the DGD database tables and fields. 
 

Select the Browse… button in the top right of the form, and browse to the \Example CPT 

Data Files\ folder from the DVD.  Select: "GEF_01.GEF" "GEF_01_D01.GEF" 

"GEF_01_D02.GEF".  The *D* files are dissipation test files related to the GEF_01.GEF 

file.  The form should now look similar to the screenshot (apart from the folder paths). 

 

 

d) Click Execute.  There will be a short pause while the Datgel code translates the data, then 
you will see a gINT progress form.   
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Finally when the import is complete a gINT Import Log form will display. 
 

 
 
It can be useful to review the Source and Target record counts to confirm the data has 
imported.  The Log also lists over write and lookup warnings.  In this case the warnings are 
of little consequence. 
 
You may now like to step through the tables in the project file, and observe the imported 
data.  Note that some values, such as those on the CPT_GLOBAL_PARAMETERS table are 
default values stored in the data template file we used to make the new project. 

2.4 Configuring Parameters and CPT Data Analysis 

The following information must be entered for the basic CPT Calculations to occur: 

 CPT Data - Upper: Test Number, Cone ID, and (optionally) Groundwater Depth 

 CPT Data - Lower: Depth, qc, fs, u2 (for CPTU) 

 CPT Cone Information: Cone ID, Cone Area Ratio (for CPTU), and Cone Sleeve Offset (used to filter rod 
change noise for fs) 
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 CPT Point Parameters: (optionally) Groundwater Depth 

 CPT Global Parameters: Most fields should be set, and these will be used as default values.  In 
particular to enable basic calculations you should define: 

 Bulk Unit Weight 

 Bulk Unit Weight Saturated 

 Soil Class Method 1 

 Soil Class Method 2 

Refer to section 7 Groundwater and Overwater Testing on page 27 for a detailed explanation of where 
to set groundwater data. 

When you change the value of related fields the CPT Tool table calculation will automatically initiate.  
You can suppress the automatic calculation by checking Suppress Automatic Calculation on CPT Global 
Parameters. 

The resulting CPT Data screen should look like this: 

 

2.5 Transfer Summary of Material Description 

We will now transfer a summary of the soil layers to the Strata Main table.  Call the command Add-Ins > 
Datgel CPT Tool > Transfer Description and Consistency for current PointID, then move to Main 
Group | Strata Main to see the transferred descriptions. 

2.6 Output a Log 

To produce a log output click on the OUTPUT tab. 

From the Logs tab, select the Report CPTU SU DR A3L, and the PointID GEF_01.  Then click preview, 
and you should see this: 
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2.7 More Information 

Refer to section Dissipation Test Analysis for a tutorial on that subject. 

Refer to section Tutorial: Creating a new Correlation in the Formula Tool for a tutorial on that subject. 
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3 Project Tables 
The test and interpreted data is stored in the project database.   

A number of constants and assumptions are required in derivations.  Many may be set globally (on CPT 
Global Parameters), for each PointID (on CPT Point Parameters), by depth for a PointID (on CPT Point Material 
Properties) and some for each push (on CPT Data – Upper).  This gives the user full control on which level in 
the hierarchy to use.  

3.1 POINT 

When an Elevation is changed the Tool will calculate.  The PointID and HoleDepth fields must be defined. 

3.2 CPT Data – Upper (CPT_GENERAL or STCG) 

This table defines each CPT push within a PointID, since under some circumstances multiple CPT 
pushes take place in the same hole.  Each push has a unique Test Number.   

 

3.3 CPT Data – Lower (CPT_DATA or STCT) 

This table stores the actual raw depth related data for each push and derived results related to each 
reading. 

3.4 CPT Point Parameters - Upper (CPT_POINT_PARAMETERS) 

This table stores the Point level constants and assumption values.  Hence if you wish to set the 
groundwater depth for all pushes for a PointID then that value should be entered into the 
Groundwater_Depth field on the CPT_POINT_PARAMETERS Table.  
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3.5 CPT Point Parameters - Lower 

(CPT_POINT_MATERIAL_PROPERTIES) 

A bulk unit weight depth profile may be defined for each PointID on the 
CPT_POINT_MATERIAL_PROPERTIES (STCM) table.  The depth ranges must cover the full depth of the test 
data. 

Additionally, the depth ranges for a particular PointID must not overlap in any way. You will not be able 
to save the table if overlapping depth ranges are entered. 

3.6 CPT Global Parameters (CPT_GLOBAL_PARAMETERS) 

Global / project hierarchy constants and parameters are stored on this table.   
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3.7 CPT Cone Information - Upper (CPT_CONE_INFORMATION or 

STCI) 

The cone and equipment constants are stored on this table.  For example, two important constants are 
the Cone Area Ratio and Cone Sleeve Offset. 
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3.8 CPT Cone Information - Lower (CPT_Cone_Calibration or 

STCC) 

This table can be used to record the calibration dates for each cone. 

3.9 Dissipation Test (CPT_DISSIPATION_TEST_GENERAL and 

CPT_DISSIPATION_TEST_READINGS, STDG and STDS) 

These tables store the Dissipation Test raw and derived data.   

 

3.10 CPT Design Line (CPT_DESIGN_LINE and 

CPT_DESIGN_LINE_DATA)  

These tables define the design line (required cone resistance) that can be assigned to each PointID 
and written to the CPT_Data table. 
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3.11 CPT Point Symbology (CPT_POINT_SYMBOLOGY)  

These tables store Point level overrides for the settings on CPT_PROJECT_SYMBOLOGY and 
DG_CPT_SYMBOLOGY. 

 

3.12 CPT Project Symbology (CPT_PROJECT_SYMBOLOGY)  

These table stores Project level overrides for the settings on DG_CPT_SYMBOLOGY. 
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3.13 CPT Formula Configuration 

(CPT_FORMULA_CONFIGURATION)  

These table stores Project level formulas. 
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4 Library Tables 

4.1 DG_CPT_AUTO_FILTER 

This table is a simple lookup for the filter options. 

4.2 DG_CPT_FIELD_MAP 

Stores the table and field name configuration used by the CPT Tool calculation.  This allows the user to 
set non-standard field and table names.  If a parameter is missing the AGS RTA name is used as 
default. 

 

4.3 DG_CPT_FORMULA_CONFIGURATION 

These table stores Library level formulas. 

4.4 DG_CPT_MEASUREMENT_SYSTEM 

This table is a simple lookup for the measurement system type options, based on the GEF standard. 

4.5 DG_CPT_MODIFIED_TIME_FACTOR 

Used for dissipation analysis 

4.6 DG_CPT_PORE_PRESSURE_FILTER_POSITION 

Used for dissipation analysis 
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4.7 DG_CPT_SCALE_TYPE 

This table is a simple lookup for the soil classification graph type options. 

4.8 DG_CPT_SOIL_CLASS_DATA 

This table stores the soil classification polygon data.  Users can add their own classification methods. 

 

4.9 DG_CPT_SOIL_CLASS_METHOD 

This table stores the names and graphing options for each soil classification method. 
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4.10 DG_CPT_SOIL_CLASS_ZONES 

This table stores the descriptions and graphics for each soil classification zone. 

 

4.11 DG_CPT_SOIL_CONSISTENCY 

This table stores the soil consistency and relative density terms and ranges. These are used to 
calculate the fields Relative_Density_Term and Undrained_Shear_Strength_Term on CPT_DATA table. 
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4.12 DG_CPT_SOIL_TYPE 

This table is a simple lookup for the soil type options. 

4.13 DG_CPT_SYMBOLOGY 

This table stores the library defaults for line colour and types etc.  The field references are used by 
reports and should not be altered. 
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4.14 DG_CPT_TERMINATION 

This table is a simple lookup of reasons for terminating a CPT push, based on the GEF standard. 

4.15 DG_CPT_TEST_METHOD 

List of test standards, e.g. AS 1289.6.5.1-1999. 

4.16 DG_CPT_TRANSFER_SUMMARY_DESC_CONSISTENCY 

This table stores the target table and field names soil description and consistency data summary 
transfer. 

 

4.17 DG_CPT_ZERO_LOCATION 

This table is a simple lookup for zero location. 
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5 Data Import 
The Data Import Tool allows you to import data from various file formats into gINT.  The command is 
located in INPUT Add-Ins > Datgel CPT Tool > Data Import. 

 

On load the default setting will populate the form.  In addition, the previous correspondence file used for 
each file type be loaded as default. 

5.1 Tools Menu 

 Load Defaults: Loads all selections, field values and the initial directory that has been 

previously saved as default. 

 Save Defaults: Saves defaults for File Browse Type, Friction Sleeve Offset, and Overwrite 

Option.  

 Set Initial Directory: Sets the initial browse directory so that every time you browse, it will start 

at the set directory. 

 About: Displays the version information of the Data Import Tool. 

5.2 File Browse Types 

 Individual Files: Select one or more files in a single folder manually. 

 Folder: Select a folder and all relevant files in that folder are selected automatically. 

 Folder and sub-folders: Select a folder and all relevant files in that folder and its sub-folders are 

selected automatically. 

Files paths may be manually entered or deleted from the large text box. 

5.3 File Types 

 A.P. van den Berg Gorilla! (*.*) – CPT and Dissipation 

 Access database files (*.gpj; *.mdb) 
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 AGS (*.ags)  

 Delimited Depth qc fs u (*.*) – simple file with no header, and data delimited by tab, ",", ";", or 

":".  The u data is not required, and the columns must be in the order Depth qc fs u.  The file 

name (without the extension) will be used as the PointID. 

 Douglas Partners (*.*) 

 GEF 1.1.0 (*.gef) – CPT and Dissipation.  The friction shift is applied for 1.0.0 version files 

only 

See: http://www.geonet.nl/index.html?http&&&www.geonet.nl/3.020.html 

 Geomil PlotCPT (*.T*) 

 gINT CSV (*.csv; *.txt) – regular gINT compliant csv file. 

 gINT Excel (*.xls) – regular gINT compliant excel file. 

 Hogentogler (*.cpd) 

 Pagani (*.cpt) 

 Pagani (*.dat) 

 ProbeDrill (*.txt; *.dis), you must import *.txt and *.dis files together.  The *.dis file 

and *.txt file for the one location MUST has the same file name 

 Swedish Geotechnical Format (SGF) and Geotech AB (*.cpt; *.dpt; *.ini)  

See: http://www.sgf.net/home/page.asp?sid=862&mid=2&PageId=21095 

 Vertek (*.dat) 

5.4 Overwrite Option 

These are the standard gINT overwrite options. 

5.5 Correspondence File 

gINT correspondence files need to be developed or altered to meet the needs of each companies gINT 
project database for each data source file type.  We have provided example files that meet the needs of 
Datgel‟s standard project file. 

5.6 Create Temp Import File 

During the import process the initial data files are read and transferred to a temporary file in gINT CSV 
format.  If this box is checked, the Data Import Tool will bring up a new window showing the contents of 
this temporary file, and will not continue with the import.  This file can be used as the source when 
designing an import correspondence file. 

http://www.geonet.nl/index.html?http&&&www.geonet.nl/3.020.html
http://www.sgf.net/home/page.asp?sid=862&mid=2&PageId=21095
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In this interface, click Save As to save the text as a file, or Print to print the text on a printer. You must 
save the text as a file before you can modify the text. This file can be imported into gINT with the Data 
Import Tool with gINT CSV selected as the File Type. 

5.7 Importing Multiple Pushes/Tests into one PointID 

The Depths in all pushes within the one PointID must have the same zero depth reference, hence if 
multiple pushes are done down a borehole, then when importing the Depth field must be populated with 
pre-drill Depth plus the push depth.  This can be achieved in the correspondence file if the predrill depth 
in recoded in the source data file. 

Gorilla files are a common offshore data file format, and we have seen files with the start depth of each 

test recorded in fields titled Reference Level and Depth Borehole. 

[TEST] 

<GORILLA! header> 

job number=BH-CPTU-S8-BL 

client=PETRONAS CARIGALI 

job description=SEPAT 8 LOCATION 

. 

. 

. 

operator=ZAHID/HILMI 

reference level=3.0 

reference point=M.S.L 

pre drilled=0.0 

GORILLA!-remark 1= 

. 

. 

. 

GORILLA! serie #= 

<user header> 

NORM=KTN/PCSB/08/268/SI 

START DEPTH= 

Seabed ref level= 

Seabed ref point= 

Depth borehole=3.0 
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Vanedepth= 

 

[SCALING FACTORS] 

. 

. 

. 

[DATA] 

*D:0.02#1:0.01#2:0.000#4:4#0:28! 

*D:0.04#1:0.01#2:0.000#4:4#0:29! 

*D:0.06#1:0.03#2:0.000#4:3#0:30! 

*D:0.08#1:0.04#2:0.001#4:4#0:31! 

*D:0.10#1:0.05#2:0.001#4:4#0:32! 

Gorilla File Example with relevant depth information highlighted 

Two correspondence files read the start depth from the different fields and calculate the true depth of 
each reading below the borehole reference level (typically seabed). 

 datgel_cpt_tool_dgd_2.01_gorilla_cpt_Depth_Borehole_##.gci 

 datgel_cpt_tool_dgd_2.01_gorilla_cpt_Reference_Level_##.gci 

After importing a set of test files for one PointID, you will need to manually set the POINT.HoleDepth field 
with the correct maximum depth of the test. 

5.8 Importing only the File Name from the Full File Path 

If the full file path of the source file is being imported, but you only want to import the file name, you can 
modify the gINT correspondence file (.gci) to extract the file name from the full file path to import into 
gINT. 

Open the gINT correspondence file in a text editor, and then search for the field name where the file 
path is being directed to (for example, File_Reference). Replace the existing expression with the 
following: 

<<GetListItem<<Original Expression>>,"\",<<ListCount(<<Original Expression>>)>>,"\")>>)>> 

Where <<Original Expression>> is the original expression that retrieves the full file path for that 

particular field. 
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6 CPT Filter 
The tool can filter out rod change noise for    and   . The filter algorithm works based on Penetration_Rate 
(mm/s), and if it is not in the data file, then it is calculated based on elapsed time. You can set the 
Filter_Threshold_Penetration_Rate on the CPT_GLOBAL_PARAMETERS and CPT_POINT_PARAMETERS, or use the 
default of 6 mm/s. If you manually run the filter then the threshold rate increases 1 mm/s each run per 
CPT push, i.e. the applied threshold rate = Filter_Threshold_Penetration_Rate + Filter_Count 

Data is only filtered if it is less than 95% of the mean of the previous two values, and the third and 
fourth values ahead. 

In order for the    filtering to take place, the Cone_Sleeve_Offset on the CPT_CONE_INFORMATION table must 
be defined. 

If the Auto_Filter_Calculation on the CPT_GLOBAL_PARAMETERS or CPT_POINT_PARAMETERS tables is set to 
Automatic (whichever is lower in the hierarchy with data), then the Filter will run once on import and set 
the Filter_Count field on the CPT_GENERAL table to “1”.  If Filter_Count field on the CPT_GENERAL table is set 
to less than “1” or null, the filter will run On Save. 

The filter may be run manually more times using the command INPUT | Add-Ins > Datgel CPT Tool > 
CPT Filter.  However the cursor must be in the bottom half of the CPT_DATA table. 
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7 Groundwater and Overwater Testing 

7.1 Groundwater Depth for Standard Onshore Testing 

The ground water depth is critical to many derived results, and can be defined in a number of ways.  In 
order of priority: 

1. CPT_GENERAL table, Groundwater_Depth field 

2. CPT_POINT_PARAMETERS table, Groundwater Depth field 

3. CPT_GLOBAL_PARAMETERS table, Groundwater_Depth field 

4. CPT_GLOBAL_PARAMETERS table, Groundwater_Elevation field 

If CPT_GENERAL.Water_Depth field has data then only CPT_GENERAL.Groundwater_Depth will be used.  
However, this should only be the case for over water testing. 

In the CPT_GLOBAL_PARAMETERS table, the Water_Density_Field field is also required, and should be set 
appropriately for fresh or salt water. 

On the CPT_GENERAL table Define 

 CPT_GENERAL.Water_Depth: Nothing 

 CPT_GENERAL.Zero_Location: S – Surface or Nothing 

 CPT_GENERAL.Pre_drilled_Depth: Nothing or value as required, doesn’t influence calculation 

 CPT_GENERAL.Groundwater_Depth: Distance from ground level (0 depth) to the groundwater 
surface, or use Groundwater_Depth fields on other tables listed above 

 

In situ pore pressure is calculated relative to the atmospheric pressure using the following formula: 

                   

                             

Where: 

  is the depth below the reference level 

   is the groundwater depth below the reference level 

   is the unit weight of water (defined as density in CPT_GLOBAL_PARAMETERS.Water_Density_Field) 

7.2 Overwater Testing 

The critical fields related to pore pressure calculation for over water testing are  

 CPT_GENERAL.Water_Depth 

 CPT_GENERAL.Zero_Location 

 CPT_GENERAL.Pre_drilled_Depth 

 CPT_GENERAL.Groundwater_Depth 
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If CPT_GENERAL.Water_Depth field has data then only CPT_GENERAL.Groundwater_Depth will be used.   

In the CPT_GLOBAL_PARAMETERS table, the Water_Density_Field field is also required, and should be set 
appropriately for fresh or salt water. 

The following sections describe how to handle the various overwater scenarios.  The aim of corrections 
is to make the derived data in all TestIDs/Pushes within the one PointID comparable. 

Derived parameters for tests using scenarios Zero at Seabed and Zero at Bottom of Borehole are 
comparable after the zero corrections have been applied, and the results are relative to the seabed. 

7.2.1 Zero on Deck / Surface 

In this case the transducers, including depth, are zeroed on deck (at atmospheric pressure).  Measured 
parameters don‟t require zero corrections. 

Define 

 CPT_GENERAL.Water_Depth: Distance from seawater surface to seabed surface (required for 
Total Stress) 

 CPT_GENERAL.Zero_Location: S - Surface 

 CPT_GENERAL.Pre_drilled_Depth: Nothing or value as required, doesn’t influence calculation 

 CPT_GENERAL.Groundwater_Depth: Distance from deck level (0 depth) to the seawater surface 

 

In situ pore pressure is calculated relative to the atmospheric pressure using the following formula: 

                   

                             

Where: 

  is the depth below the reference level 

   is the groundwater depth below the reference level 

   is the unit weight of water (defined as density in CPT_GLOBAL_PARAMETERS.Water_Density_Field) 

Total Stress and Effective Stress are calculated relative to deck/ground surface. 

7.2.2 Zero at Seabed 

In this scenario the transducers are zeroed at the seabed, with the hydrostatic pressure at that water 
depth.   

Define 

 CPT_GENERAL.Water_Depth: Distance from seawater surface to seabed surface (required for 
Total Stress) 

 CPT_GENERAL.Zero_Location: SB - Seabed 

 CPT_GENERAL.Pre_drilled_Depth: Nothing or value as required, doesn’t influence calculation 

 CPT_GENERAL.Groundwater_Depth: Nothing 
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The in situ pore pressure, total stress and effective stress are calculated relative to the seabed, hence: 

         

            

             

Where: 

  is the depth below the seabed 

   is the water depth, distance from seawater surface to seabed surface 

   is the unit weight of water (defined as density in CPT_GLOBAL_PARAMETERS.Water_Density_Field) 

     is the unit weight of saturated soil 

7.2.3 Zero at Bottom of Borehole 

This scenario applies when testing overwater and the transducers are zeroed the bottom of a predrilled 
borehole.  It is common for multiple 3 m pushes/tests to be done down a borehole, possibly alternated 
with other in situ tests and sampling.  The corrections allow the multiple pushes to be comparable, by 
correcting the readings relative to the seabed surface. 

Define  

 CPT_GENERAL.Water_Depth: Distance from seawater surface to seabed surface (required for 
Total Stress) 

 CPT_GENERAL.Zero_Location: BB – Bottom Borehole 

 CPT_GENERAL.Pre_drilled_Depth: Distance from seabed to bottom of borehole (where CPT 
started) 

 CPT_GENERAL.Groundwater_Depth: Nothing 

 

In this scenario the    and    will be corrected using the following formulas before they are used by the 
calculation code: 

     
         

     
       

The in situ pore pressure, total stress and effective stress are calculated relative to the seabed, hence: 

             

                

             

The CPT Tool calculation assumes data in the Depth field = d + z 

Lunne et al. (1997) and Fugro (1995) 

Where: 
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   is the cone resistance corrected 

  
  is the cone resistance measured 

   is the pore pressure corrected 

  
  is the pore pressure measured 

  is the cone area ratio 

   is the unit weight of water (defined as density in CPT_GLOBAL_PARAMETERS.Water_Density_Field) 

  is the pre-drilled depth, depth from the seabed to bottom of the borehole where the CPT 
started 

  is the depth below the bottom of the borehole 

   is the water depth, distance from seawater surface to seabed surface 

     is the unit weight of saturated soil 

1. The depth reference level for all TestIDs/Pushes in a PointID must be the same.  Hence, when importing 
pushes with the reference depth at the bottom of the borehole the correspondence file must include the 
calculation Depth = d + z. 

2. Dissipation tests measured pore pressure and in situ pore pressure are corrected as described above.  
And again Depth of the Dissipation test must = d + z. 
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8 Bulk Unit Weight and Void Ratio 
Unit Weight and Void ratio may be defined in two locations and are used in the order listed: 

1. CPT_POINT_MATERIAL_PROPERTIES table.  This allows the user to enter a depth profile.  If a 
depth range is missing a value, then the CPT_GLOBAL PARAMETERS table is used. 

2. CPT_GLOBAL PARAMETERS table.  A saturated and unsaturated unit weight must be defined, the 
former is applied bellow the water table and the later above the water table.  

If Unit Weight and Void Ratio are not defined in either table, then the Bulk Unit Weight and Void Ratio 
will not be defined, and most other parameters cannot be calculated. 
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9 Initiation of the CPT Data Calculation 

9.1 Primary Table Calculations 

The primary CPT calculation is initiated by changing data then saving on the following tables (or the 
split screen parent of these tables): 

 POINT 

 CPT_DATA 

 CPT_MATERIAL_PROPERTIES 

 CPT_GLOBAL_PARAMETERS 

 CPT_CONE_INFORMATION 

 CPT_DESIGN_LINE_DATA 

 

The CPT calculation on POINT will only run when an existing POINT record has records on the CPT_DATA 
table, and the Elevation has changed and the new Elevation has a value. 

The automated CPT calculation when saving on these tables can be stopped by checking 
Suppress_Automatic_Calculation on CPT_GLOBAL_PARAMETERS. 

The calculation will not run when converting projects. 

Unless the Suppress_Calculation_on_Import on CPT_GLOBAL_PARAMETERS is checked, the calculation will 
take place upon import. 

When calling gINT Rules > Recalculate Current Table from a CPT Table a form will display giving you 
options. 

 

 Yes: will recalculate all CPTs in the project, this is equivalent to changing a value on the Global 
Parameter table.  This is the fastest way to revaluate the entire database of CPTs.  A progress 
bar will be shown to display the progress of the calculation.  This is normally the option to pick. 

 No: will use gINT‟s native recalculate current table, which can be a very inefficient way to 
calculate the database of CPTs.  This option is not recommended. 

 Cancel: Cancels the call, and nothing is calculated. 
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9.2 Order of Calculation 

The order of calculation is: 

1. Derived parameters 

2. Soil Behaviour Type 

3. Correlations hard coded: Undrained shear strength 1 and 2, Constrained Modulus, Coefficient 
of Volume Change, Compression Index, Soil Type Index Ic, N60 and N60 Average 

4. Formula Tool – Library formulas 

5. Formula Tool – Project formulas 

9.3 Dissipation Test 

The Dissipation test calculation is independent of the rest of the CPT table calculations.  You may need 
to manually make the Dissipation test recalculate after changing relevant CPT parameters / data for a 
PointID. 
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10 Derived Parameters 
The following table presents the derived parameters.  These calculations are hard coded, and are 
calculated before the Formula Tool. 

Table 2 - Derived Parameters 

DGD Field Name AGS RTA 
Field Name 

Caption Symbol Unit Description 

Penetration_Rate     Rate calculated based on 
Time_Elapsed and Depth 

Bulk_Unit_Weight STCT_BUW Bulk Unit Weight           Bulk unit weight,     

In_Situ_Pore_Pressure STCT_PWPI In Situ u        In situ pore pressure,   , refer to 

section 7 for a full explanation. 

Excess_Pore_Pressure STCT_PWPE Delta u        Excess pore pressure,  
             

Normalised_Excess_Pore_
Pressure 

 Normalised Delta 
u 

Normalis
ed    

 Normalised excess pore 

pressure, normalised     
        

    
 

 

Total_Stress STCT_TOTS Total Stress         In situ total vertical stress,     

Effective_Stress STCT_EFFS Effective Stress          In situ effective vertical stress, 
     

Total_Cone_Resistance STCT_QT qt         Total cone resistance,  

                        ;  

or if the instrument is zeroed at 
the bottom of the borehole 
(downhole)  

     
                   

        

Total_Cone_Resistance_Mo
ving_Average 

 Moving Average 
qt 

     Moving average qt over distance 
defined on 
CPT_GLOBAL_PARAMETERS 

Total_Cone_Resistance_Mo
ving_Average_Inc 

 Moving Average 
qt Included 

     Moving average qt that are not 
excluded over distance defined 
on CPT_GLOBAL_PARAMETERS 

Net_Cone_Resistance STCT_QNET Qn        Net cone resistance,  

                   

Corrected_Sleeve_Friction STCT_FT Ft         Sleeve friction corrected for pore 
pressure effects, 

          
          –          

  
 

Friction_Ratio STCT_FRR Rf      Friction ratio, 

     
  

     
     , 

  

     
     , or 

  

     
      

Normalised_Friction_Ratio STCT_FR Fr      Normalised friction ratio, 

      
  

       
       

 

If     is not found, and if 

Calc_Qt_Fr_based_on_qc on 
CPT_GLOBAL_PARAMETERS is set 
to true, then      is used in place 

of   . 
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DGD Field Name AGS RTA 
Field Name 

Caption Symbol Unit Description 

Normalised_Cone_Resistan
ce 

STCT_QNOR Qt    - Normalised cone resistance, 

    
      

  –     

  
   

 

If     is not found, and if 

Calc_Qt_Fr_based_on_qc on 
CPT_GLOBAL_PARAMETERS is set 
to true, then      is used in place 

of   . 

Stress_Normalised_Cone_R
esistance 

Stress_Normalise
d_Cone_Resistan
ce 

qt1     - Stress normalised cone 
resistance (Kulhawy and Mayne 
1990, Jamiolkowski et al 

2001),       
      

 

      
        

 

Pore_Pressure_Ratio STCT_BQ Bq    - Pore pressure ratio, 

      
  

       –    
 

Differential_Pore_Pressure_
Ratio 

STCT_DPPR DPPR      - Differential pore pressure ratio, 
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11 Formula Tool 

11.1 Introduction 

The Formula Tools allows you to review and edit the preconfigured correlation formulas provided with 
the CPT Tool, and provides a way for you to define new correlation formulas.   

A tutorial is provided in Section 11.7 Tutorial: Creating a new Correlation in the Formula Tool. 

To Launch the Formula Tool Configuration, call the command INPUT | Add-Ins > Datgel CPT Tool > 
Formula Tool Configuration. 

You should see a window similar to the following. 
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11.2 Formula Toolbar 

 

Hovering the mouse cursor over each item will show a tooltip with a short description of the item.  

Name Icon/Image Keyboard Shortcut Description 

New Formula  Ctrl + N Creates a new empty formula 

Save Formula  Ctrl + S Saves all changes to the gINT Library or 
Project database, depending on the selected 
Location 

Delete Formula  Ctrl + D Deletes the currently selected formula 

Undo Changes  Ctrl + U Reverts any changes made to the current 
formula to the state it was last saved 

Copy Current 
Formula 

 Ctrl + Shift + C Makes a copy of the currently selected 
formula, and adds it to the end of the Formula 
Grid. After copying, the copied formula will be 
selected, and you must enter a new unique 
name. 

Enable all 
Formulas 

  Checks the Enabled check box column for all 
formulas in the Formulas Grid 

Disable all 
Formulas 

  Unchecks the Enabled check box column for 
all formulas in the Formulas Grid 

Location 
 

 Location the Formula Configurations are 
stored. Select Library to load the Configuration 
stored in the current gINT Library, and Project 
to load the Configuration stored in the current 
gINT Project. 

 

At the time of CPT calculation, The Library 
formulas will be evaluated and calculated first, 
followed by the Project formulas. 

Generate 
Validation 
Report for 
Current 
Formula 

  Generates a report containing full details of the 
currently selected formula, evaluated validation 
result and any errors or missing Table Field 
references in the current formula. 

 

Clicking the button will prompt you for a new 
text file path, and then automatically open the 
text file in a text editor program after the report 
has been generated. 

Generate 
Validation 
Report for All 
Formulas 

  Generates a report containing full details of the 
all formulas showing in the formula grid, 
evaluated validation result and any errors or 
missing Table Field references for each 
formula. 

 

Clicking the button will prompt you for a new 
text file path, and then automatically open the 
text file a text editor program after the report 
has been generated. 

11.3 Data Tool Toolbar 

 

Hovering the mouse cursor over each item will show a tooltip with a short description of the item.  
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Name Icon/Image Keyboard 
Shortcut 

Description 

Refresh Data 
Tool 

 Ctrl + R Clears, re-reads and reloads the Table 
and Field drop down list items from the 
current gINT Project. Use this to 
update the drop down list if you have 
added a new table or field after the 
Formula Configuration Form has been 
opened. 

Table Field 
Data Tool  

 Pastes the selected table and field as 
formatted text into the last focused 
configuration field. Refer to the Table 
Field Data Tool section of the manual 
for detailed information 

Function Data 
Tool  

 Pastes the selected function text into 
the last focused configuration field. 
Refer to the Function Data Tool section 
of the manual for detailed information 

11.3.1 Table Field Data Tool 

 

The Table Field Data Tool pastes the selected table and field as formatted text into the last focused 
configuration field.  The drop down list contains all tables and fields in the current gINT Project 
database.  When a Table is selected, the Field list will automatically filter to show only the fields for the 
selected table. 

The Table and Field drop down lists consist of three columns: 

 
 

 Table Name/Field Name – database name of the Table or Field 

 Caption – The caption text as configured in the Caption field in the gINT Table or Field 
Properties 

 Description – The description text as configured in the Description field in the gINT Table or 
Field Properties 

The drop down list can be sorted by a column by clicking on the column header.  The columns can be 
resized by clicking and dragging the edges of the column header left or right.  The drop down list 
window can be resized by clicking and dragging the bottom right corner of the window. 

The Paste  button will insert the selected table field into a formatted, table field reference text into 
the last focused configuration text field or grid cell.  The Paste button can insert text into the following 
Configuration fields: 

 Description 

 Any cell in the Variables Grid 
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 Formula 

 Write Value To 

The table field reference format is as below: 

<<Table Name.Field Name>> 

Table field references in the Formula field are required to be surrounded by quotation marks.  The 
Table Field Data Tool will automatically add the quotation marks if pasting in the Formula field. The 
table field reference format for the Formula field is as below: 

"<<Table Name.Field Name>>" 

The pasted text will be inserted at the current position of the cursor in the fields.  Any highlighted text 
will be replaced by the inserted text.  Selecting an entire cell in the Variables grid will replace the 
contents of that cell with the inserted text. 

11.3.2 Function Data Tool 

 

The Table Field Data Tool pastes the selected function text into the last focused configuration field.  
The Function drop down list contains all functions, constants and operators that are available in the 
Formula Tool, it the correct syntax.  Each function is categorised as a type, and selecting a type in the 
Type drop down list will filter the function drop down list by that type. 

 

The Function drop down list consists of three columns: 

 Type – type of function, can be filtered by a particular type by selecting a type in the Type drop 
down list 

 Function – the function, constant or operator in the correct syntax as required by the Formula 
Tool.  The typical syntax composition of a function consists of the function name, followed by 
an open bracket, followed by a comma separated list of function parameters, followed by a 
closed bracket. 

FunctionName(Parameter 1, Parameter 2 [,...]) 

The function name is case sensitive.  All function parameters are required, unless noted 

otherwise.  If a function accepts an arbitrary number of parameters, it is denoted by ... . 

 Description – A short description about the function 

The Paste  button will insert the selected table field into a formatted, table field reference text into 
the last focused configuration text field or grid cell.  The Paste button can insert text into the following 
Configuration fields: 

 Description 

 Any cell in the Variables Grid 

 Formula 
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 Write Value To 

11.4 Formulas Group 

 

The Formulas Group contains a list of formulas listed in the currently selected location.  Each row in the 
Grid represents one formula, and is listed in the order they are to be evaluated from first to last. 

Selecting a formula by either by clicking on a row, or pressing the up or down keys in the Grid will 
display the configuration associated with the selected formula in the Configuration Group.  The Name 
and Enabled column values cannot be changed in this grid. It must be done in the Configuration Group 
after the formula has been selected. 

The Order of the formula can be changed in the Formulas Group with the up down buttons on the top 
left.  Descriptions of the bottom are listed below from top to bottom: 

 Move to Top – Moves the currently selected formula to the top of the grid 

 Move Up – Moves the currently selected formula up by one row 

 Move Down – Moves the currently selected formula down by one row 

 Move to Bottom – moves the currently selected formula to the bottom of the grid 
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11.5 Configuration Group 

 

The Configuration Group contains all the configurable options for the formula that is currently selected 
in the Formulas Grid. 

 Name – Name of the formula.  The formula name must be unique for the configuration location.  
This means that you may have two formulas with the same name in the current Library and 
Project, but not in the Library or Project only.   
 
You will not be able to select another formula, or save the formula until a unique name is 
entered. 

 Order – a numeric value of the order the formula will be evaluated.  If the result of the current 
formula is required to evaluate another formula, then the current formula should be placed at a 
higher order to than the other formula. 
 
The order cannot be changed in the Configuration Group.  Move the selected formula up or 
down using the up down buttons left of the Formulas Grid.  The numeric Order value will 
update itself when the order has changed.  

 Iteration - The round of iteration in which the current formula will be evaluated.  Default value 
is 1.  Functions which calculate the average of a correlation that is evaluated by the Formula 
Tool need to be run at a later iteration to the correlation. 

 Description – Description of the formula.  It is not used or required in the formula calculation, 
and hence it is an optional field. 

 Table/Field References to Variables – Declare the variables that are used in the formula 
expression in this grid.  The rows in this grid can be changed with the up down buttons on the 
left of this grid. Column definitions are listed below: 

 Variable Name – Name of the variable.  The variable name can consist of alphanumeric 
characters [a-z, A-Z, 1-9], but must have at least one alphabetic character, and is case 
sensitive.  It cannot contain the following: 
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o Symbols, such as `, $, # 
o White spaces or carriage return 
In addition, a duplicate variable names for a particular formula is not permitted, and a 
variable name cannot be exactly the same as a function name. 

 Expression – Table Field reference to where the variable value is to be retrieved from, or a 
text or numeric value.  The following is a list of rules and specifications regarding the 
Expression: 

o Table Field references must be in the format of <<Table.Field>> 

o If the referenced field is from the CPT_DATA table, then it will take the value from the 
field of the current row the CPT Tool is calculating. 

o If the referenced field is from any other table, it will retrieve the first result from a query 
to that table, filtered by the PointID and ItemKey values of the current CPT calculation, 
where appropriate. 

o To use the variable as a constant, enter a numeric value, or text that is not in the 

format of <<Table.Field>> 

 Validation Value – Value used to evaluate the formula when the Validate button is clicked, 
and in the Validation Reports.  The Validation Value has no effect on the actual CPT 
calculation, and is solely used in the Formula Configuration Form. 

 Formula – The formula expression.  Refer to the Functions section of this manual for a full list 
of available functions.  Variables declared in the Variables Grid above can be referenced in the 
formula expression.  String constants must be surrounded with quotation marks "" in order to 
differentiate it from a variable reference.  Spaces and carriage returns may be used liberally to 
improve readability. 
 
Table field references in the formula expression must be surrounded by quotation marks, i.e. 

"<<Table.Field>>".  The Table Field Data Tool will automatically add the quotation marks 

when pasted in the formula expression field. 

 Write Value To – The Table Field reference to where the result of the formula evaluation is to 

be written to.  The value in this field must be in the <<Table.Field>> format, and must be 

from the CPT_DATA table. 

 Validate – Click this button to evaluate the current formula expression, with the Validation 
Value set as the Variables.  If the evaluation was successful, the result will be written to the 
adjacent text field.  The Formatting Type and Value will be applied to the result, if defined.  Use 
Validate to spot check your formula expression for syntax errors, and to verify the formula 
returns an expected result. 

 Enabled – Check or uncheck to enable or disable the formula respectively from evaluating in 
the CPT calculation 

 Formatting Type and Value – Formats the result to either decimal or significant figures, to the 
nearest specified value.  The formatting only applies to formula expressions that return a 
numeric value. 

 OK – Saves the current state of the formulas in the Formula Configuration form to the selected 
location, and closes the form. 

 Cancel – Discards any changes made in the Formula Configuration form and closes the form.  
The formulas will remain at the exact same state as before the Formula Configuration form was 
opened.  You will be prompted to save if changes are detected. 

11.6 Functions 

 

Type Description Function Name  

Constants π, 3.14159 Pi 
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Constants Euler's Constant e, 2.71828 e 

Constants Boolean constant true true 

Constants Boolean constant false false 

Log and Exponential Natural Logarithm ln(x) 

Log and Exponential Logarithm base 10 log(x) 

Log and Exponential Logarithm base 2 lg(x) 

Log and Exponential Exponential (e^x) exp(x) 

Log and Exponential Power pow(x) 

Miscellaneous If if(cond, trueval, falseval) 

Miscellaneous Absolute Value / Magnitude abs(x) 

Miscellaneous Binomial coefficients binom(n, i) 

Miscellaneous First Data, returns first non-empty value from list first(x1,x2,x3,...) 

Miscellaneous Lookup Interval Range 

LookupIntervalRange("<<Current Interval 
Table.Field>>","<<Lookup Value 
Table.Field>>","<<Top Interval 
Table.Field>>","<<Bottom Interval 
Table.Field>>") 

Miscellaneous Modulus mod(x,y) 

Miscellaneous Modulus  x % y 

Miscellaneous Moving Average 

MovingAverage("<<Current Interval 
Table.Field>>","<<Values to Average 
Table.Field>>",Thickness) 

Miscellaneous Random number (between 0 and 1) rand() 

Miscellaneous Stepped Average 

SteppedAverage("<<Current Interval 
Table.Field>>","<<Values to Average 
Table.Field>>",Thickness) 

Miscellaneous Stepped Extrapolation 

SteppedExtrapolation("<<Current Interval 
Table.Field>>","<<Values to Extrapolate 
Table.Field>>") 

Miscellaneous Square Root sqrt(x) 

Miscellaneous Sum sum(x,y,...) 

Miscellaneous Str (number to string) str(x) 

Miscellaneous Table Interval Average 

TableIntervalAverage("<<Current Interval 
Table.Field>>","<<Values to Average 
Table.Field>>","<<Top Interval 
Table.Field>>","<<Bottom Interval 
Table.Field>>") 

Operators Addition + 

Operators Subtraction - 

Operators Division / 

Operators Multiplication * 

Operators Unary Plus +x 

Operators Unary Minus -x 

Operators Power ^ 

Operators Modulus % 

Operators Boolean Not ! 

Operators Boolean And && 
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Operators Boolean Or || 

Operators Equal == 

Operators Not Equal != 

Operators Less Than < 

Operators Greater Than or Equal > 

Operators Less or Equal <= 

Operators Greater Than or Equal >= 

Rounding Round round(x) 

Rounding Round round(x, p) 

Rounding Floor floor(x) 

Rounding Ceiling ceil(x) 

Statistical Average avg(x1,x2,x3,...) 

Statistical Minimum min(x1,x2,x3,...) 

Statistical Maximum max(x1,x2,x3,...) 

Trigonometric Sine (in radians) sin(x) 

Trigonometric Cosine (in radians) cos(x) 

Trigonometric Tangent (in radians) tan(x) 

Trigonometric Arc Sine (in radians) asin(x) 

Trigonometric Arc Cosine (in radians) acos(x) 

Trigonometric Arc Tangent (in radians) atan(x) 

Trigonometric Arc Tangent (with 2 parameters, in radians)  atan2(y, x) 

Trigonometric Hyperbolic Sine (in radians) sinh(x) 

Trigonometric Hyperbolic Cosine (in radians) cosh(x) 

Trigonometric Hyperbolic Tangent (in radians) tanh(x) 

Trigonometric Inverse Hyperbolic Sine (in radians) asinh(x) 

Trigonometric Inverse Hyperbolic Cosine (in radians) acosh(x) 

Trigonometric Inverse Hyperbolic Tangent (in radians) atanh(x) 

11.6.1 Special Functions 

Functions that require explanation in greater detail are listed in this section. 

11.6.1.1 MovingAverage 

MovingAverage("<<Current Interval Table.Field>>","<<Values to Average 

Table.Field>>",Thickness) 

The Moving Average function returns an arithmetic mean of values above and below the current interval 
field value. 

Below is a definition of the parameters for MovingAverage: 

 "<<Current Interval Table.Field>>" – Table field reference to the interval that determines the 
current interval value, and the range of averages.  As denoted by the parameter name, the 
table field reference must be surrounded with quotation marks. 

 The values in the interval field must be uniformly increasing or decreasing in value with no 
duplicates.  A Typical interval field would be Depth. 
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 "<<Values to Average Table.Field>>" – Table field reference for the values to average.  The 
data set of the average is obtained from this field.  The field does not need to be a numeric 
type, but the values must be numeric.  As denoted by the parameter name, the table field 
reference must be surrounded with quotation marks. 

 Thickness – Defines the interval range of the values taken for the average, where the current 
interval is the middle of the range.  Therefore, the minimum and maximum range of the 
average would be the current interval + thickness / 2 and current interval - thickness / 2 
respectively. 

The Current Interval and the Values to Average table field references must refer to a field from the 
CPT_DATA table. 

If the moving average is used with a correlation evaluated by the Formula Tool, then the Iteration of the 
moving average formula must be greater than the iteration of the correlation. 

The Moving Average cannot be evaluated via the Validate button or in Validation Reports from the 
Formula Tool Configuration Form. 

Below is a working example configuration of    Moving Average: 

 

 

In this example, an average of    values above and below the given depth will be written to the 
Cone_Resistance_Moving_Average field in the CPT_DATA field. The distance above and below can be 
configured in the CPT_GLOBAL_PARAMETERS table, in the field Moving_Average_Thickness. The thickness 
defines the depth range of the    values taken, where the given depth is in the middle of the range. 

For example, specifying a Moving_Average_Thickness of 1 m, the    values are taken from ±0.5 m from the 
given depth. 
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11.6.1.2 SteppedAverage 

SteppedAverage("<<Current Interval Table.Field>>","<<Values to Average 

Table.Field>>",Thickness) 

The Stepped Average function returns an arithmetic mean of values within an interval range that 
increments by the specified thickness.  A graph of a set of stepped average values against the interval 
will appear as horizontal steps of equal width that step up or down.   

Below is a definition of the parameters for SteppedAverage: 

 "<<Current Interval Table.Field>>" – Table field reference to the interval that determines the 
current interval value, and the range of averages.  As denoted by the parameter name, the table 
field reference must be surrounded with quotation marks. 

The values in the interval field must be uniformly increasing or decreasing in value with no 
duplicates.  A Typical interval field would be depth. 

 "<<Values to Average Table.Field>>" – Table field reference for the values to average.  The 
data set of the average is obtained from this field.  The field does not need to be a numeric 
type, but the values must be numeric.  As denoted by the parameter name, the table field 
reference must be surrounded with quotation marks. 

 Thickness – Defines the interval increment range of the values taken for the average. 

The Current Interval and the Values to Average table field references must refer to a field from the 
CPT_DATA table. 

The Stepped Average cannot be evaluated via the Validate button or in Validation Reports from the 
Formula Tool Configuration Form. 

If the moving average is used with a correlation evaluated by the Formula Tool, then the Iteration of the 
moving average formula must be greater than the iteration of the correlation. 

Below is a working example configuration of SPT N60 Stepped Average: 
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The SPT average N60 value is a stepped average of values in the SPT_N60_1 field on the CPT_DATA 
table for each defined depth interval step.  

The average of the N60 values is calculated for each depth interval step, and the result is recorded in 
the SPT_Average_N60_1 field in the CPT_DATA table for each row in that interval step. 

The depth interval distance (thickness) is defined on the SPT_N60_Average_Interval field on 
CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables.  The first function dictates that the value 
in the CPT_POINT_PARAMETERS table has precedence over the CPT_GLOBAL_PARAMETERS table. 

For example, specifying a SPT_N60_Average_Interval of 1 m, the stepped average value at a depth of 0.5 
m would be the average SPT N60 values between 0 m and 1 m. 

11.6.1.3 TableIntervalAverage 

TableIntervalAverage("<<Current Interval Table.Field>>","<<Values to Average 

Table.Field>>","<<Top Interval Table.Field>>","<<Bottom Interval Table.Field>>") 

The Table Interval Average function returns an arithmetic mean of values within an interval range 
specified on another Table.  A graph of a set of table interval average values against the interval will 
appear as horizontal steps whose width is top and bottom intervals specified on the corresponding 
table.  Conceptually, the Table Interval Average is similar to the Stepped Average, but the step widths 
are defined by the Top and Bottom interval values. 

Below is a definition of the parameters for TableIntervalAverage: 

 "<<Current Interval Table.Field>>" – Table field reference to the interval that determines the 
current interval value, and the range of averages.  As denoted by the parameter name, the 
table field reference must be surrounded with quotation marks. 

The values in the interval field must be uniformly increasing or decreasing in value with no 
duplicates.  A Typical interval field would be Depth. 
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 "<<Values to Average Table.Field>>" – Table field reference for the values to average.  The 
data set of the average is obtained from this field.  The field does not need to be a numeric 
type, but the values must be numeric.  As denoted by the parameter name, the table field 
reference must be surrounded with quotation marks. 

 "<<Top Interval Table.Field>>" – Table field reference to the field that contains the top 
interval values 

 "<<Bottom Interval Table.Field>>" – Table field reference to the field that contains the 
bottom interval values 

The Current Interval and the Values to Average table field references must refer to a field from the 
CPT_DATA table, and the Top and Bottom interval table field references must refer to fields from the 
same table. 

The Stepped Average cannot be evaluated via the Validate button or in Validation Reports from the 
Formula Tool Configuration Form. 

The Stepped Average assumes that there is only one set of top and bottom intervals for each CPT data 
keyset, and that the top and bottom interval values do not create overlapping layers. 

Below is a working example configuration of    Strata Average: 

 

In this example, the cone resistance is averaged between the strata layers as defined by the Depth and 
Bottom fields in the STRATA_MAIN table, for the current PointID. 

11.6.1.4 SteppedExtrapolation 

SteppedExtrapolation("<<Current Interval Table.Field>>","<<Values to Extrapolate 

Table.Field>>") 
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The Stepped Extrapolation function returns a value that is extrapolated to the midpoint between the 
current value to extrapolate, and the next value to extrapolate.  From the current value to extrapolate to 
the midpoint, Stepped Extrapolation returns the current value to extrapolate, and from the midpoint to 
the next value to extrapolate, Stepped Extrapolation returns the next value to extrapolate. 

Below is a definition of the parameters for SteppedExtrapolation: 

 "<<Current Interval Table.Field>>" – Table field reference to the interval that determines the 
current interval value, and is a reference point to determine the midpoint between two values to 
extrapolate.  As denoted by the parameter name, the table field reference must be surrounded 
with quotation marks. 

The values in the interval field must be uniformly increasing or decreasing in value with no 
duplicates.  A Typical interval field would be Depth. 

 "<<Values to Extrapolate Table.Field>>" – Table field reference for the values to extrapolate.    
The field does not need to be a numeric type, but the values must be numeric.  As denoted by 
the parameter name, the table field reference must be surrounded with quotation marks. 

The Current Interval and the Values to Extrapolate table field references must refer to a field from the 
CPT_DATA table. 

The Stepped Extrapolation cannot be evaluated via the Validate button or in Validation Reports from 
the Formula Tool Configuration Form. 

Below is a working example configuration Shear Wave Velocity Extrapolated: 

 

Results: 
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11.6.1.5 LookupIntervalRange 

LookupIntervalRange("<<Current Interval Table.Field>>","<<Lookup Value 

Table.Field>>","<<Top Interval Table.Field>>","<<Bottom Interval Table.Field>>") 

The Lookup Interval Range function returns the a value for a specified field from another depth related 
table, where the current interval value in the CPT_DATA table lies in between the Top and Bottom 
intervals in the other table. 

Below is a definition of the parameters for LookupIntervalRange: 

 "<<Current Interval Table.Field>>" – Table field reference to the interval that determines the 
current interval value that is used as a search criteria for the value on the other table.  As 
denoted by the parameter name, the table field reference must be surrounded with quotation 
marks. 

The values in the interval field must be uniformly increasing or decreasing in value with no 
duplicates.  A Typical interval field would be depth. 

 "<<Lookup Value Table.Field>>" – Other table field reference for the value to retrieve. 

 "<<Top Interval Table.Field>>" – Other table field reference to the field that contains the top 
interval values 

 "<<Bottom Interval Table.Field>>" – Other table field reference to the field that contains the 
bottom interval values 

The Current Interval must refer to a field from the CPT_DATA table, and the Top and Bottom interval, and 
Lookup Value table field references must refer to fields from the same table. 

The Lookup Interval Range cannot be evaluated via the Validate button or in Validation Reports from 
the Formula Tool Configuration Form. 

The Lookup Interval Range assumes that there is only one set of top and bottom intervals for each CPT 
data keyset, and that the top and bottom interval values do not create overlapping layers.  If more than 
one matching value for the current interval is found, then the first value is returned. 
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Below is an example usage of the Lookup Interval Range function that retrieves the Void Ratio value 
from the Void_Ratio field in the CPT_MATERIAL_PROPERTIES table, where the current CPT_DATA depth lies 
between the top and bottom depths in the CPT_MATERIAL_PROPERTIES table. 

LookupIntervalRange( 

  "<<CPT_DATA.Depth>>" 

, 

  "<<CPT_POINT_MATERIAL_PROPERTIES.Void_Ratio>>" 

, 

  "<<CPT_POINT_MATERIAL_PROPERTIES.Depth>>" 

, 

  "<<CPT_POINT_MATERIAL_PROPERTIES.Bottom>>" 

) 

11.7 Tutorial: Creating a new Correlation in the Formula Tool 

In this tutorial, we will create a formula titled Undrained Shear Strength 5, which is the same as 
Undrained Shear Strength 3.  For more details on the correlation refer to Undrained Shear Strength 3 
section in this user guide. 

For quick reference, the equation is as below: 

                           

We will start by creating the fields necessary to support this correlation. 

Go to the DATA DESIGN | Project Database tab, and then call the command File > Open File > 
Current Project. 

Select CPT_DATA from the yellow table drop down list from the top, and then add a new field by clicking 
on the New button. 

Fill in the fields with the following values, and click OK when finished. 

Field Name Value 

Name Undrained_Shear_Strength_5 

Caption Su 5 Tutorial 

Type Double 

Description Undrained shear strength from CSSM (method 5), Su = 0.5 * 
sin phi' * OCR^lambda * sig vo'; phi' is taken from the first of 
these fields with data: Effective_Friction_Angle_3 and 
Effective_Friction_Angle_1; OCR is taken from 
Overconsolidation_Ratio_1; Lambda stored on 
CPT_POINT_MATERIAL_PROPERTIES, 
CPT_POINT_PARAMETERS and 
CPT_GLOBAL_PARAMETERS tables 

Units kPa 

Cell Color Field - Calculated 
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Select CPT_GLOBAL_PARAMETERS from the yellow table drop down list from the top, and then add a new 
field by clicking on the New button. 

Fill in the fields with the following values, and click OK when finished. 

Field Name Value 

Name Undrained_Shear_Strength_5_Lambda 

Type Double 

Description Undrained shear strength from CSSM (method 5), Su = 0.5 * 
sin phi' * OCR^lambda * sig vo'; phi' is taken from the first of 
these fields with data: Effective_Friction_Angle_3 and 
Effective_Friction_Angle_1; OCR is taken from 
Overconsolidation_Ratio_1; This field represents lambda; 
Typically low to medium sensitivity clays are 0.7 <= lambda <= 
0.8 , and sensitive and structured clays are 0.9 <= lambda <= 
1.0 

Default Value 0.85 

Cell Color Field – Enter Data 

We will now copy this field into the CPT_POINT_PARAMETERS table.  Select CPT_POINT_PARAMETERS from 
the yellow drop down list from the top.  

Call the command Tables > Merge Fields from Current File.  Select CPT_GLOBAL_PARAMETERS and 
click OK.  Then select Undrained_Shear_Strength_Tutorial_5 and click OK.  Clear the Default Value.  Click 
Save to save the changes. 

Go back to the INPUT tab and launch the Formula Tool Configuration Form, by calling the command 
Add-Ins > Datgel CPT Tool > Formula Tool Configuration. 

 

The Formula Tool Configuration Form should appear. 
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Change the Location drop down to Project.  Click on the new Icon to create a new blank formula. 

We will now use the Table Field Data Tool to insert a table field reference to the configuration.   

In the Configuration Group, Click on the Write Value To text field so that the cursor is blinking in the 
text field.  Click on the Table drop down list, and select CPT_DATA.  Then click on the Field drop down 
list, and select Undrained_Shear_Strength_5. 

The Table Field Drop Down list should look like the following: 

 

Click on the Paste button.  <<CPT_DATA.Undrained_Shear_Strength_5>> should have 

been pasted in the Write Value To field. 

NOTE: You are free to type the table field references.  However, using the Table Field Data Tool eliminates 
typographical errors which will cause errors and unexpected results further down the track.  Hence, you are 
encouraged to use the Table Field Data Tool to insert table field references, as typographical errors can be 
difficult to find afterwards.  

In the Configuration Group, fill in the following values. 

Field Name Value 

Name Undrained Shear Strength 5 



 

 

CPT Tool gINT Add-In 2  Datgel 
User Guide 54 DCT-UG-001 - 2.10 - September 2010 
 

Iteration 1 

Description Undrained shear strength from CSSM (method 5), Su = 0.5 * sin phi' * 
OCR^lambda * sig vo'; phi' is taken from the first of these fields with data: 
Effective_Friction_Angle_3 and Effective_Friction_Angle_1; OCR is taken 
from Overconsolidation_Ratio_1; Lambda stored on 
CPT_POINT_MATERIAL_PROPERTIES, CPT_POINT_PARAMETERS and 
CPT_GLOBAL_PARAMETERS tables 

Book: NCHRP Synthesis 368 pp39 

Write Value To <<CPT_DATA.Undrained_Shear_Strength_5>> 

Enabled Check this option. 

Formatting Type Decimal Places 

Value 1 

We will now enter the variables in the Table/Field References to Variables Grid. 

Click on the Variable Name column, first row.  Type in PhiD1 minding the case of each character. 

Click on the Expression column, first row.  Go to the Table Field Data Tool, and select the CPT_DATA 
table, Effective_Friction_Angle_1 field.  Click on the Paste button, and this should insert 

<<CPT_DATA.Effective_Friction_Angle_1>> in the cell in the first row of the Expression 

column. 

Click on the Validation Value column, first row.  Enter 15 in the cell. 

We have just finished entering one variable, PhiD1 which represents    from the equation. 

Repeat the last three steps to enter the rest of the variables listed below: 

Variable 
Name 

Expression Validation 
Value 

Represents  
Variable in the 
Equation 

PhiD1 <<CPT_DATA.Effective_Friction_Angle_1>> 15    

PhiD3 <<CPT_DATA.Effective_Friction_Angle_3>> 10    

OCR <<CPT_DATA.Overconsolidation_Ratio_1>> 3     

SigDV0 <<CPT_DATA.Effective_Stress>> 100      

PjLambda <<CPT_GLOBAL_PARAMETERS.Undrained_Shear_Strength_

5_Lambda>> 

0.7   

PtLambda <<CPT_POINT_PARAMETERS.Undrained_Shear_Strength_5

_Lambda>> 

0.8   
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SoilType <<CPT_DATA.Soil_Type_1>> Fine  

TIP: You can use the up down arrows adjacent to the Variable Grid on the left to change the order the 
variables appear in the Grid.  The order does not affect the formula calculation in any way. 

We are now ready to write the Formula. 

Click on the Formula text field so that the cursor is blinking in the text field.  Go to the Function Data 

Tool, select Miscellaneous as the Type, then select the If() function.   

The Function Data Tool should look like the following:  

 

Click on the Paste button.  if(cond, trueval, falseval) should have been pasted in 

the Formula field. 

NOTE: You are free to type the function names.  However, using the Function Data Tool eliminates 
typographical errors which will cause errors and unexpected results further down the track.  Additionally, it 
helps you to set up the proper function syntax for the formula.  Hence you are encouraged to use the 
Function Data Tool to insert functions, as typographical errors can be difficult to find afterwards.  

Parameters and Functions are case sensitive. 

Enter the following text in the formula field, using the Function Data Tool when needed: 

if( 

  SoilType == "Fine" || SoilType == "Mixed" || SoilType == "" 

, 

  0.5 * sin(first(PhiD3,PhiD1)/180*pi) * OCR^ first(PtLambda,PjLambda) * SigDV0 

, 

  "" 

) 

An explanation of the formula is as below: 

If( 

  SoilType == "Fine" || SoilType == "Mixed" || SoilType == "" ... 

Check to see if the Soil Type is either “Fine”, “Mixed” or empty.  If it is, then evaluate the equation, 

otherwise, return empty.  || denotes an OR logical operation, and == denotes an EQUAL TO text 

comparison. 

first(PhiD3,PhiD1) 

The first() function returns the first non-empty value (from left to right) in the list of parameters.  If both 

PhiD3 and PhiD1 have values, then the first value, PhiD3 is returned. 

sin(first(PhiD3,PhiD1)/180*pi) 

The parameter for the sine function in the Formula Tool must be in radians.  PhiD3 and PhiD1 are in 

Degrees, so the value is converted to radians by dividing by 180, then multiplying by pi.  
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TIP: You can use spaces and carriage returns (new line) to format, and space out your formula for better 
readability.  The formatting method used in this tutorial separates the function name, parameters, parameter 
delimiters and closing bracket in a new line, and the parameters are indented by two spaces. 

For example, 

FunctionName(Parameter1,Parameter2,FunctionName2(Parameter1,Parameter2)) 

Becomes 

FunctionName( 

  Parameter1 

, 

  Parameter2 

, 

  FunctionName2( 

  , 

    Parameter1 

  , 

    Parameter2 

  ) 

) 

Using a consistent formatting standard throughout your collection of formulas will allow you to quickly read 
and understand a formula, and enables you to find errors easily.  

Your screen should look similar to the following: 

 

Click the save  button to save the formula to your Project.  After saving, the formula name should be 
visible in the Formulas Grid on the left side. 
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We are now ready to validate the formula.  Click on the Validate  button.  This will 
substitute variables in the Formula with the corresponding value in the Validation Value column in the 
Variables Grid, and then evaluate the equation. 

If everything has been correctly entered, a value of 20.9 will appear in the text field adjacent to the 

Validate button.  Otherwise, an error message will show, detailing why the validation failed.  Read the 
error message carefully and fix your configuration accordingly.  Then click the Validate button again to 
validate the configuration.  Repeat until no errors are shown, and the correct value is returned. 

The details of our formula can be saved to a text file, so that it may be archived, printed or distributed.  

Click on the Generate Validation Report for Current Formula  button.  Specify a file name and 
path for the new text file and click Save.  

The text file will be created, and will be automatically opened in your default text editor. 

 

Return to the Formula Tool Configuration form, and click OK to close the form. 
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We are now ready to calculate the Undrained Shear Strength 5 correlation in the CPT_DATA table.  

Go to INPUT | CPT | CPT Global Parameters tab, and enter 0.7 in the 

Undrained_Shear_Strength_Tutorial_5_Lambda field. 

Go to INPUT | CPT | CPT Data tab, and select GEF_01 as the PointID.  Click on the bottom half of the 
screen and change a value to enable the Save button.   

Click Save. Assuming that you have entered a value in all table fields referenced in the Variables Grid, 
and there is a value in the Effective_Stress field, and Soil_Type_1 is either “Fine”, “Mixed” or empty, you 
should see a value in the newly created Undrained_Shear_Strength_5 field. 

Over 50 working correlations in the Formula Tool have been provided to you with the CPT Tool standard 
gINT Files.  A good way to learn how to use the Formula Tool is by learning from example.  You may use 
these existing correlations as a basis to create new correlations that suit your requirements.  The Copy 

Formula  button on the Formula Configuration form is useful feature to quickly create multiple formulas 
that have only small differences. 

You may also copy rows in the parameter grid to other correlations. 

Now we will add the new correlation to the CPT Symbology tables. 

Go to DATA DESIGN | Library Data tab and select DG_CPT_SYMBOLOGY from the yellow table drop 
down list.  

Correctly assign the Data Template field, and then add a new row at the bottom with the following 
values, using the Data Tool when appropriate: 
 

Column Name Value 

Parameter Undrained Shear Strength 5 

gINT Field Name <<CPT_DATA.Undrained_Shear_Strength_5>> 

SQL Field Name [CPT_DATA].[Undrained_Shear_Strength_5] 

Unit kPa 

Line Colour Very Light Magenta 

Line Type Solid 

Line Thickness 0.2 

Data Marker 5 

Data Marker Height Log 0 

Data Marker Height Graph  

Minimum Scale 0 

Maximum Scale 500 

Automatic Scale  

Automatic Scale Round To  

Show on Report True 

Remark  

Name Undrained Shear Strength 

Abbreviation S<<SUB>>u<<SUB>> 

Reference Wroth (1984) 

Reference Short  

 



 

 

CPT Tool gINT Add-In 2  Datgel 
User Guide 59 DCT-UG-001 - 2.10 - September 2010 
 

Go to INPUT | CPT | CPT Project Symbology.  Scroll to the bottom, and select Undrained Shear 

Strength 5 from the drop down list in the Parameter column.  For the Undrained Shear 

Strength 3 parameter, Set the Show on Report column value to false. 

Values entered in this table will take precedence over the values in the DG_CPT_SYMBOLOGY library 
table.  Therefore, The Undrained Shear Strength 3 parameter will not be shown on reports generated 
with this project file. 

We will now output a dynamic report showing the calculated values in our newly created     field. 

Go to OUTPUT | Logs tab, and select the CPT DYNAMIC A4P log report from the yellow drop down 
list.  Select GEF_01 in PointID field.   

Click on the Print or Preview button, and the User Report Variables window will show. Fill in the 
following values and click OK. 

Name Value 

Column 1 QT QC FT FS WITH MINOR 

Column 2 RF SLOPE INDICATOR 

Column 3 UNDRAINED SHEAR STRENGTH 

Column 4  

Column 5  

Column 6  

Column 7  

Column 8  

Column 9  

Column 10  

Width 1 (mm)  

Width 2 (mm) 45 

Width 3 (mm) 45 

Width 4 (mm)  

Width 5 (mm)  

Width 6 (mm)  

Width 7 (mm)  

Width 8 (mm)  

Width 9 (mm)  

Width 10 (mm)  

Show qc qt Average Legend Check this option. 

Show Dissipation Legend Check this option. 

Show Design Line Legend Check this option. 

Legend 1 UNDRAINED SHEAR STRENGTH 

Legend 2  

Below is an output of the report, exported as a png file. 
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12 Correlations 
The primary references for the correlation was Mayne (2007) and Lunne et al. (1997). 

Many of the correlations listed in this section use constants within a formula.  Users can set the 
constants in the following tables.  The tables are listed in order of priority. 

1. CPT_POINT_MATERIAL_PROPERTIES 

2. CPT_POINT_PARAMETERS 

3. CPT_GLOBAL_PARAMETERS 

For example, if the Relative_Density_1_C0 field on CPT_POINT_PARAMETERS has a value it will be used in 
preference to the value, if any, on the CPT_GLOBAL_PARAMETERS table. 

The fields in the CPT_POINT_MATERIAL_PROPERTIES table allow the constants to be defined for depth 
ranges for a particular PointID.  A top and bottom depth must be specified when using the 
CPT_POINT_MATERIAL_PROPERTIES table, and the depth ranges must not overlap.  

12.1 Soil Behaviour Type 

The CPT Tool is supplied with five material type interpretation methods: 

 Robertson 1990 

 Robertson 1990 Extrapolated (axis extrapolated out) 

 Robertson et al. 1986 

 Robertson et al. 1986    vs.    (Applicable when u2 isn‟t measured) 

 Schneider et al. 2008 (defined by formula in paper‟s table 6) 

Additional methods may be defined by users in the DG_CPT* library tables.  See section 13 Creating a 
New Soil Behaviour Type. 

The CPT_DATA table allows for two methods to be defined.  The methods are set on the 
CPT_GLOBAL_PARAMETERS and the CPT_POINT_PARAMETERS tables.   

The interpretation is done using 2 graphs, and then the first single result is used as the overall material 
classification.  E.g. if Soil Zone 1 Graph 1 = 9,10,11,12 and Soil Zone 1 Graph 2 = 9, then Soil Class 
Number 1 will = 9. 

If a point lies on the boarder of two zones, then the soil zone will be an appended string of both 
numbers, e.g. “9,10”.  The material type graph reports will print a black do for these duel points. 

If the graph parameters are not within the range of the graph, then the Description field is set to “No 
Match”. 
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12.2 Undrained Shear Strength and Consistency Term 

12.2.1 Undrained Shear Strength 1 

Undrained Shear Strength 1 (   ) in Undrained_Shear_Strength_Term_1 is defined as: 

When qt has data, 

   
              

   
 

Otherwise, 

    
              

  
 

   and     are defined on the CPT_POINT_MATERIAL_PROPERTIES, CPT_POINT_PARAMETERS and 
CPT_GLOBAL_PARAMETERS tables. Different values for    and     can be defined for when    or    is 
either greater than or equal to, or less than a defined break point. Each of these tables have six fields 
from which the    and     values, and the    and    break point values are stored and retrieved for the 

calculation of   . 

Field Name Description 

Undrained_Shear_Strength_1_Nk_qc_BP Break point used to determine which    to use in the 
    calculation 

Undrained_Shear_Strength_1_Nk_qc_LT_BP Used as the    in the     calculation, where    does not 

have data, and    is less than the break point. 
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Field Name Description 

Undrained_Shear_Strength_1_Nk_qc_GTE_BP Used as the    in the     calculation, where    does not 

have data, and    is greater than or equal to the break 

point. 

Undrained_Shear_Strength_1_Nkt_qt_BP Break point used to determine which     to use in the 

    calculation 

Undrained_Shear_Strength_1_Nkt_qt_LT_BP Used as the     in the     calculation, where    has data, 

and    is less than the break point. 

Undrained_Shear_Strength_1_Nkt_qt_GTE_BP Used as the     in the     calculation, where    has data, 

and    is greater than or equal to the break point. 

The fields in the CPT_POINT_MATERIAL_PROPERTIES table allow the    and     to be defined for depth 
ranges for a particular PointID.  A top and bottom depth must be specified when using the 
CPT_POINT_MATERIAL_PROPERTIES table, and the depth ranges must not overlap.  

If the CPT_POINT_MATERIAL_PROPERTIES table is populated for the calculated PointID, the    or     that 
lies within the depth range of the current depth of the row in the CPT_DATA table is used to calculate   . 
If a matching depth range for the current depth is not found, or    or     is missing, then the value is 
taken from the CPT_POINT_PARAMETERS or the CPT_GLOBAL_PARAMETERS tables. 

12.2.2 Undrained Shear Strength 1 Term 

The Undrained_Shear_Strength_Term_1 is defined based on the value of the Undrained_Shear_Strength_1 field 
and the values in the DG_CPT_SOIL_CONSISTENCY library table. 

12.2.3 Undrained Shear Strength 2 

Undrained Shear Strength 2 (   ) in Undrained_Shear_Strength_Term_2 is defined as: 

When qt has data, 

   
        

   
 

Otherwise, 

    
        

  
 

Where: 

    is stored in the Undrained_Shear_Strength_2_Nkt field. 

   is stored in the Undrained_Shear_Strength_2_Nk field. 

The variables are stored on CPT_POINT_MATERIAL_PROPERTIES, CPT_POINT_PARAMETERS and 
CPT_GLOBAL_PARAMETERS tables. 

The fields in the CPT_POINT_MATERIAL_PROPERTIES table allow the    and     to be defined for depth 
ranges for a particular PointID.  A top and bottom depth must be specified when using the 
CPT_POINT_MATERIAL_PROPERTIES table, and the depth ranges must not overlap.  
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If the CPT_POINT_MATERIAL_PROPERTIES table is populated for the calculated PointID, the    or     that 
lies within the depth range of the current depth of the row in the CPT_DATA table is used to calculate   . 
If a matching depth range for the current depth is not found, or    or     is missing, then the value is 
taken from the CPT_POINT_PARAMETERS or the CPT_GLOBAL_PARAMETERS tables. 

12.2.4 Undrained Shear Strength 2 Term 

The Undrained_Shear_Strength_Term_2 is defined based on the value of the Undrained_Shear_Strength_2 field 
and the values in the DG_CPT_SOIL_CONSISTENCY library table. 

12.2.5 Undrained Shear Strength 3 

Undrained Shear Strength 3 (   ) based on CSSM in Undrained_Shear_Strength_3 is defined as: 

When qt has data, 

                           

Wroth (1984), NCHRP Synthesis 368 pp 39 

Where: 

   is taken from the first of these fields with data: Effective_Friction_Angle_3 and 
Effective_Friction_Angle_1 

    is taken from Overconsolidation_Ratio_1 

         , typically low to medium sensitivity clays are           , and sensitive and 
structured clays are          , and is stored in the Undrained_Shear_Strength_3_Lambda field. 

  is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.2.6 Undrained Shear Strength 3 Term 

The Undrained_Shear_Strength_Term_3 is defined based on the value of the Undrained_Shear_Strength_3 field 
and the values similar to that in DG_CPT_SOIL_CONSISTENCY library table. 

12.2.7 Undrained Shear Strength 4 

Undrained Shear Strength 4 (   ) in Undrained_Shear_Strength_4 is defined as: 

             

Trak et al. (1980), Terzaghi et al. (1996), NCHRP Synthesis 368 pp 40 

Where: 

     is taken from Preconsolidation_Stress_1 

   is 0.22 in the published formula, and is stored in the Undrained_Shear_Strength_4_C1 field. 

   is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 
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12.2.8 Undrained Shear Strength 4 Term 

The Undrained_Shear_Strength_Term_4 is defined based on the value of the Undrained_Shear_Strength_4 field 
and the values similar to that in DG_CPT_SOIL_CONSISTENCY library table. 

12.3 Relative Density and Relative Density Term 

12.3.1 Relative Density 1 

Relative density (  ) in Relative_Density_1 is defined as: 

      
 

  
    

           

            
  

       

Baldi et al. (1986) and Al-Homoud and Wehr (2006), CPT in Geotechnical Practice pp 83 

Where: 

   is stored in the Relative_Density_1_C0 field.  Published value for normally consolidated 157, 
over consolidated 181 

   is stored in the Relative_Density_1_C1 field.  Published value for normally consolidated 0.55, 
over consolidated 0.55 

   is stored in the Relative_Density_1_C2 field.  Published value for normally consolidated 2.41, 
over consolidated 2.46 

     is the Wehr Correction for Calcareous Soils, this constant is defined in the 
Relative_Density_1_Wehr_Correction field and was suggested in Al-Homoud and Wehr (2006).  If the 
field is empty the default is 1. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.3.2 Relative Density Term 1 

Relative density term in Relative_Density_Term_1 is defined based on Relative_Density_1 on the CPT_DATA 
table and the values in the DG_CPT_SOIL_CONSISTENCY library table. 

12.3.3 Relative Density 2 

Relative density (  ) in Relative_Density_2 is defined as: 

              
       

          
      

Jamiolkowski et al. (2001), NCHRP Synthesis 368 pp 41-42 

Where: 

   is stored in the Relative_Density_2_C1 field.  Published value is 0.268 for all sands 

   is stored in the Relative_Density_2_C2 field.  For average compressibility: C2 = -0.675, for high 
compressibility and sands of carbonate or calcareous composition: C2 <= 1.0, for low 
compressibility: C2 >= -2.0 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 
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12.3.4 Relative Density Term 2 

Relative density term in Relative_Density_Term_2 is defined based on Relative_Density_2 on the CPT_DATA 
table and the values in the DG_CPT_SOIL_CONSISTENCY library table. 

12.3.5 Relative Density 3 

Relative density (  ) in Relative_Density_3 is defined as: 

       
   

                                    
 
   

     

Kulhawy and Mayne (1990), CPT in Geotechnical Practice pp 84 

Where: 

   is stored in the Relative_Density_3_C1 field.  Published values range from 0.91 for low 
compressibility, 1.0 for medium compressible sands, to 1.09 for highly compressible 

  is time in years and stored in the Relative_Density_3_t field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.3.6 Relative Density Term 3 

Relative density term in Relative_Density_Term_3 is defined based on Relative_Density_3 on the CPT_DATA 
table and the values in the DG_CPT_SOIL_CONSISTENCY library table. 

12.4 Soil Behaviour Type Index 

12.4.1 Soil Behaviour Type Index 1 

The soil behaviour type index (  ) in Soil_Behaviour_Type_Index_1 is defined as: 

                 
                

      

Robertson and Wride (1998) 

Where: 

   is 3.47 in the published formula, and is stored in the Soil_Behaviour_Type_Index_1_C1 field. 

   is 1.22 in the published formula, and is stored in the Soil_Behaviour_Type_Index_1_C2 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.4.2 Soil Behaviour Type Index 2 

The soil behaviour type index (  ) in Soil_Behaviour_Type_Index_2 is defined as: 

                                            

Jefferies and Davies (1993) 

Where: 
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   is 3 in the published formula, and is stored in the Soil_Behaviour_Type_Index_2_C1 field. 

   is 1.5 in the published formula, and is stored in the Soil_Behaviour_Type_Index_2_C2 field. 

   is 1.3 in the published formula, and is stored in the Soil_Behaviour_Type_Index_2_C3 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.5 SPT N60 Value 

12.5.1 SPT N60 Value 1 

The SPT     in SPT_N60_1 is defined as: 

     
      

           
  
  

 
 

Robertson and Wride (1998), CPT in Geotechnical Practice pp 151 

Where: 

   is 8.5 in the published formula, and is stored in the SPT_N60_1_C1 field. 

   is 4.6 in the published formula, and is stored in the SPT_N60_1_C2 field. 

   is the Atmospheric pressure, 100 kPa, and cannot be changed in the CPT Tool. 

   is stored in the Soil_Behaviour_Type_Index_1 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.5.2 SPT N60 Value 2 

The SPT     in SPT_N60_2 is defined as: 

     
  

       
  
  

 
 

Jefferies and Davies (1993) 

Where: 

   is 0.85 in the published formula, and is stored in the SPT_N60_2_C1 field. 

   is 4.75 in the published formula, and is stored in the SPT_N60_2_C2 field. 

   is stored in the Soil_Behaviour_Type_Index_2 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.6 SPT Average N60 Value 

The SPT average N60 value is a stepped average of SPT N60 values in the SPT_N60_1 or SPT_N60_2 
fields in the CPT_DATA table for each defined depth interval step.  
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The average of the N60 values is calculated for each depth interval step, and the result is recorded in 
the SPT_ Average_N60_1 or SPT_Average_N60_2 fields in the CPT_DATA table for each row in that interval 
step. 

The depth interval distance is defined on the SPT_N60_Average_Interval field on CPT_POINT_PARAMETERS 
and CPT_GLOBAL_PARAMETERS tables, and is in metres.  

12.7 Shear Wave Velocity 

12.7.1 Shear Wave Velocity 1 

Shear Wave velocity 1 (  ) in Shear_Wave_Velocity_1 is defined as: 

 
                    

Mayne (2006), NCHRP Synthesis 368 pp 30 

Where: 

   is 118.5 in the published formula, and is stored in the Shear_Wave_Velocity_1_C1 field. 

   is 18.5 in the published formula, and is stored in the Shear_Wave_Velocity_1_C2 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.7.2 Shear Wave Velocity 2 

Shear Wave velocity 2 (  ) in Shear_Wave_Velocity_2 is defined as: 

 

                         
    

  
      

      
  

  

Hegazy and Mayne (1995), NCHRP Synthesis 368 pp 30 

Where: 

   is 10.1 in the published formula, and is stored in the Shear_Wave_Velocity_2_C1 field. 

   is 11.4 in the published formula, and is stored in the Shear_Wave_Velocity_2_C2 field. 

   is 1.67 in the published formula, and is stored in the Shear_Wave_Velocity_2_C3 field. 

   is 0.3 in the published formula, and is stored in the Shear_Wave_Velocity_2_C4 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation of    is calculated when the Soil_Type_1 field value on the CPT_DATA table has any value 
for that row. 

12.7.3 Shear Wave Velocity 3 

Shear Wave velocity 3 (  ) in Shear_Wave_Velocity_3 is defined as: 
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Mayne and Rix (1995), NCHRP Synthesis 368 pp 30 

Where: 

   is 1.75 in the published formula, and is stored in the Shear_Wave_Velocity_3_C1 field. 

   is 0.627 in the published formula, and is stored in the Shear_Wave_Velocity_3_C2 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation of    is calculated only when the Soil_Type_1 field value on the CPT_DATA table is Fine or 
Mixed for that row. 

12.7.4 Shear Wave Velocity 4 

Shear Wave velocity 4 (  ) in Shear_Wave_Velocity_4 is defined as: 

 

         
                  

Baldi et al. (1989), NCHRP Synthesis 368 pp 30 

Where: 

   is 277 in the published formula, and is stored in the Shear_Wave_Velocity_4_C1 field. 

   is 0.13 in the published formula, and is stored in the Shear_Wave_Velocity_4_C2 field. 

   is 0.27 in the published formula, and is stored in the Shear_Wave_Velocity_4_C3 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation of    is calculated only when the Soil_Type_1 field value on the CPT_DATA table is Coarse 
or Mixed for that row. 

12.8 Unit Weight 

12.8.1 Dry Unit Weight 1 

Dry Unit Weight 1 (    ) in Dry_Unit_Weight_1 is defined as: 

 

                       

Mayne (2007), NCHRP Synthesis 368 pp 31 

Where: 

   is 1.89 in the published formula, and is stored in the Dry_Unit_Weight_1_C1 field. 

   is 11.8 in the published formula, and is stored in the Dry_Unit_Weight_1_C2 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation of    is calculated only when the Soil_Type_1 field value on the CPT_DATA table is Coarse 
or Mixed for that row. 
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12.8.2 Saturated Unit Weight 1 

Saturated Unit Weight 1 (    ) in Saturated_Unit_Weight_1 is defined as: 

 
                             

Mayne (2007), NCHRP Synthesis 368 pp 31 

Where: 

   is 8.32 in the published formula, and is stored in the Saturated_Unit_Weight_1_C1 field 

   is 1.61 in the published formula, and is stored in the Saturated_Unit_Weight_1_C2 field 

  is Depth 

   is taken from the first of these fields with data: Shear_Wave_Velocity_Extrapolated or 
Shear_Wave_Velocity_1  

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation is applicable to all soil types. 

12.8.3 Saturated Unit Weight 2 

Saturated Unit Weight 2 (    ) in Saturated_Unit_Weight_2 is defined as: 

 
                          

Mayne (2007), NCHRP Synthesis 368 pp 32 

Where: 

   is 2.6 in the published formula, and is stored in the Saturated_Unit_Weight_2_C1 field 

   is 15 in the published formula, and is stored in the Saturated_Unit_Weight_2_C2 field 

   is 26.5 in the published formula, and is stored in the Saturated_Unit_Weight_2_C3 field 

   is Specific Gravity of Solids, typically 2.4 to 2.9, and is stored in the Specific_Gravity_of_Solids 
field on CPT_GLOBAL_PARAMETERS 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation is applicable to all soil types. 
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12.9 Small-Strain Shear Modulus 

12.9.1 Small-Strain Shear Modulus 1 

Small-Strain Shear Modulus 1 (  ) of sand in Small_Strain_Shear_Modulus_1 is defined as: 

 

         
       

 

     
 

  

     

Rix and Stokoe (1992), CPT in Geotechnical Practice pp 94 

Where: 

   is 1634 in the published formula, and is stored in the Small_Strain_Shear_Modulus_1_C1 field 

   is -0.75 in the published formula, and is stored in the Small_Strain_Shear_Modulus_1_C2 field 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation of    is calculated only when the Soil_Type_1 field value on the CPT_DATA table is Coarse 
or Mixed for that row. 

12.9.2 Small-Strain Shear Modulus 2 

Small-Strain Shear Modulus 2 (  ) in Small_Strain_Shear_Modulus_2 is defined as: 

 

    
     

 
     

  

Elastic theory, CPT in Geotechnical Practice pp 74 and 94, NCHRP Synthesis 368 pp 32 

Where: 

   is taken from the first of these fields with data: Shear_Wave_Velocity_Extrapolated or 
Shear_Wave_Velocity_1 

      is taken from Bulk_Unit_Weight 

This correlation of    is applicable to all soil types. 

12.10 Young’s Modulus 

Young‟s Modulus 1 (  ) in Youngs_Modulus_1 is defined as: 

                

Elastic theory, CPT in Geotechnical Practice pp 74 and 94, NCHRP Synthesis 368 pp 32 

Where: 

  = 0.2 is applied and can be varied in the Formula Tool.  Published literature states:    = 0.2 
applies for drained soils and    = 0.5 applies for undrained soils 

   is taken from Small_Strain_Shear_Modulus_2 
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This correlation of    is applicable to all soil types. 

12.11 Constrained Modulus 

12.11.1 Constrained Modulus 1 

The constrained modulus 1 ( ) in Constrained_Modulus_1 is defined as: 

                    

Kulhawy and Mayne (1990), NCHRP Synthesis 368 pp 33 

Where: 

   is 8.25 in the published formula, and is stored in the Constrained_Modulus_1_C1 field. 

The constant is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.11.2 Constrained Modulus 2 

The constrained modulus 2 ( ) in Constrained_Modulus_2 is defined as: 

        

Burns and Mayne (2002), NCHRP Synthesis 368 pp 33-34 

Where: 

   is 0.02 for organic plastic clays up to 2 for over consolidated quartz sands in the published 
literature, and is stored in the Constrained_Modulus_2_C1 field 

   is taken from Small_Strain_Shear_Modulus_2 

The constant is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation of   is applicable to all soil types. 

This global approach to defining    is potentially inaccurate, it would be better to define the constant based 
on soil type with depth. 

12.12 Coefficient of Volume Change 

The coefficient of volume change 1 (  ) in Coefficent_Volume_Change_1 is defined as: 

   
 

 
 

Where: 

  the constrained modulus, and is taken from the Constrained_Modulus_1 field. 

12.13 Compression Index 

The Compression Index 1 (  ) in Compression_Index_1 is defined as: 
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Where: 

   is 2.3 in the published formula, and is stored in the Compression_Index_1_C1 field. 

  is the Void Ratio, and is stored in the Void_Ratio field. 

  is the constrained modulus, and is taken from the Constrained_Modulus_1 field. 

The constant and   are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS 
tables. 

12.14 Preconsolidation Stress and Overconsolidation Ratio 

12.14.1 Preconsolidation Stress 1 and Overconsolidation Ratio 1 

The Preconsolidation Stress 1 (   ) of clay in Preconsolidation_Stress_1 is defined as: 

                      

Mayne (1995), Demers and Leroueil (2002), NCHRP Synthesis 368 pp 34 

Where: 

   is 0.33 in the published formula, and is stored in the Preconsolidation_Stress_1_C1 field. 

The constant is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

The overconsolidation ratio 1 in Overconsolidation_Ratio_1 is defined as: 

    
   

    
 

    is taken from Preconsolidation_Stress_1 field 

12.14.2 Preconsolidation Stress 2 and Overconsolidation Ratio 2 

The Preconsolidation Stress 2 (   ) of clay in Preconsolidation_Stress_2 is defined as: 

  
        

Chen and Mayne (1996), NCHRP Synthesis 368 pp 34 

Where: 

   is 0.53 in the published formula, and is stored in the Preconsolidation_Stress_2_C1 field. 

The constant is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

The overconsolidation ratio 2 in Overconsolidation_Ratio_2 is defined as: 

    
   

    
 

    is taken from Preconsolidation_Stress_2 field 
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12.14.3 Preconsolidation Stress 3 and Overconsolidation Ratio 3 

The Preconsolidation Stress 3 (   ) of clay in Preconsolidation_Stress_3 is defined as: 

                     

Mayne (2005), NCHRP Synthesis 368 pp 35 

Where: 

   is 0.6 in the published formula, and is stored in the Preconsolidation_Stress_3_C1 field. 

The constant is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

The overconsolidation ratio 3 in Overconsolidation_Ratio_3 is defined as: 

    
   

    
 

    is taken from Preconsolidation_Stress_3 field 

12.14.4 Preconsolidation Stress 4 and Overconsolidation Ratio 4 

The Preconsolidation Stress 4 (   ) of clay in Preconsolidation_Stress_4 is defined as: 

  
       

        

Robertson (2009), Guide to CPT pp 31 

Where: 

   is 0.25 in the published formula, and is stored in the Preconsolidation_Stress_4_C1 field 

   is 1.25 in the published formula, and is stored in the Preconsolidation_Stress_4_C2 field 

The constant is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

The overconsolidation ratio 4 in Overconsolidation_Ratio_4 is defined as: 

    
   

    
 

    is taken from Preconsolidation_Stress_4 field 

12.14.5 Preconsolidation Stress 5 and Overconsolidation Ratio 5 

The Preconsolidation Stress 5 (   ) of sand in Preconsolidation_Stress_5 is defined as: 

  
    

                  

                        
 

 
 

          
 

      

Mayne (2005), NCHRP Synthesis 368 pp 35 

Where: 

   is 0.192 in the published formula, and is stored in the Preconsolidation_Stress_5_C1 field 
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   is 0.22 in the published formula, and is stored in the Preconsolidation_Stress_5_C2 field 

   is 0.31 in the published formula, and is stored in the Preconsolidation_Stress_5_C3 field 

   is 0.27 in the published formula, and is stored in the Preconsolidation_Stress_5_C4 field 

   is taken from Effective_Friction_Angle_3 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

The overconsolidation ratio 5 in Overconsolidation_Ratio_5 is defined as: 

    
   

    
 

    is taken from Preconsolidation_Stress_5 field 

12.14.6 Preconsolidation Stress 6 and Overconsolidation Ratio 6 

The Preconsolidation Stress 6 (   ) of all soil types in Preconsolidation_Stress_6 is defined as: 

  
          

                  
   

Mayne (2007), NCHRP Synthesis 368 pp 35 

Where: 

   is 0.101 in the published formula, and is stored in the Preconsolidation_Stress_6_C1 field 

   is 0.102 in the published formula, and is stored in the Preconsolidation_Stress_6_C2 field 

   is 0.478 in the published formula, and is stored in the Preconsolidation_Stress_6_C3 field 

   is 0.420 in the published formula, and is stored in the Preconsolidation_Stress_6_C4 field 

   is taken from Small_Strain_Shear_Modulus_2 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

The overconsolidation ratio 6 in Overconsolidation_Ratio_6 is defined as: 

    
   

    
 

    is taken from Preconsolidation_Stress_6 field 

12.15 Effective Angle of Friction 

12.15.1 Effective Angle of Friction 1 

The effective angle of internal friction of mixed soils (  ) in Effective_Friction_Angle_1 is defined as: 

          
                      

Mayne and Campanella (2005), NCHRP Synthesis 368 pp 38-39 

Where: 
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   is 29.5 in the published formula, and is stored in the Effective_Friction_Angle_1_C1 field. 

   is 0.121 in the published formula, and is stored in the Effective_Friction_Angle_1_C2 field. 

   is 0.256 in the published formula, and is stored in the Effective_Friction_Angle_1_C3 field. 

   is 0.336 in the published formula, and is stored in the Effective_Friction_Angle_1_C4 field. 

This correlation of    is only applicable for               and hence will only be calculated if    in the 

Pore_Pressure_Ratio field on the same row lies within this range.  

12.15.2 Effective Angle of Friction 2 

The effective angle of internal friction of sand (  ) in Effective_Friction_Angle_2 is defined as: 

                       
     

 

    
   

Robertson and Campanella (1983), NCHRP Synthesis 368 pp 38 

Where: 

   is 0.1 in the published formula, and is stored in the Effective_Friction_Angle_2_C1 field. 

   is 0.38 in the published formula, and is stored in the Effective_Friction_Angle_2_C2 field. 

This correlation of    is only applicable for Sands and hence will only be calculated if the Soil_Type_1 
field value is coarse or mixed.  

12.15.3 Effective Angle of Friction 3 

The effective angle of internal friction of sand (  ) in Effective_Friction_Angle_3 is defined as: 

                     

Kulhawy and Mayne (1990), NCHRP Synthesis 368 pp 38 

Where: 

   is 17.6° in the published formula, and is stored in the Effective_Friction_Angle_3_C1 field. 

   is 11.0° in the published formula, and is stored in the Effective_Friction_Angle_3_C2 field. 

This correlation of    is only applicable for Sands and hence will only be calculated if the Soil_Type_1 
field value is coarse or mixed.  

12.1 Effective Cohesion 

12.1.1 Effective Cohesion 1 

The cohesion (  ) in Effective_Cohesion_1 is defined as: 

            

Mayne and Stewart (1988), Mesri and Abdel-Ghaffar (1993), NCHRP Synthesis 368 pp 44 

Where: 
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   is 0.02 in the published formula, and is stored in the Effective_Cohesion_1_C1_C1 field. 

    is taken from Preconsolidation_Stress_1field. 

12.2 Sensitivity 

12.2.1 Sensitivity 1 

The Sensitivity (  ) in Sensitivity_1 is defined as: 

   
  

  
 

Schmertmann (1978b), Rad and Lunne (1986), CPT in Geotechnical Practice pp 68 

Where: 

   is a value between 5 and 10 in the published formula, and is stored in the Sensitivity_1_Ns field. 

The constant is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.2.2 Sensitivity 2 

The Sensitivity    in Sensitivity_2 is defined as: 

   
                

  
 

Mayne (2007), NCHRP Synthesis 368 pp 41 

Where: 

   is 0.073 in the published formula, and is stored in the Sensitivity_2_C1 field. 

The constant is stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation of    is based on the assumption of OCR < 2,             and                  . 

The value of    is recorded in the Sensitivity_2 field on the CPT_DATA table. 

12.3 Coefficient of Lateral Earth Pressure 

12.3.1 Coefficient of Lateral Earth Pressure 1 

Coefficient of Lateral Earth Pressure 1 (  ) is recorded in the Coefficient_Lateral_Earth_Pressure_1 is defined 
as: 

 

                       

                
         

         
 

Mayne (2007), NCHRP Synthesis 368 pp 42 

Where: 



 

 

CPT Tool gINT Add-In 2  Datgel 
User Guide 78 DCT-UG-001 - 2.10 - September 2010 
 

    is taken from the Overconsolidation_Ratio_1 field on the CPT_DATA table.  

   is taken from the Effective_Friction_Angle_3 and Effective_Friction_Angle_1 field on the CPT_DATA 
table.  

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.3.2 Coefficient of Lateral Earth Pressure 2 

Coefficient of Lateral Earth Pressure 2 (  ) is recorded in the Coefficient_Lateral_Earth_Pressure_2 is defined 
as: 

 

        
      

    
 

  

  
    

    
 
  

       

Mayne (2007), NCHRP Synthesis 368 pp 43 

Where: 

    is taken from the Overconsolidation_Ratio_5 field on the CPT_DATA table.  

   is 0.192 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_2_C1 
field. 

   is 0.22 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_2_C2 field. 

   is 0.31 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_2_C3 field. 

   is 0.27 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_2_C3 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.3.3 Coefficient of Lateral Earth Pressure 3 

Coefficient of Lateral Earth Pressure 3 (  ) is recorded in the Coefficient_Lateral_Earth_Pressure_3 is defined 
as: 

 

        
          

    
  

Kulhawy and Mayne (1990), CPT Guide pp 32 

Where: 

   is 0.1 in the published formula, and is stored in the Coefficient_Lateral_Earth_Pressure_3_C1 field. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

12.4 Rigidity Index 

12.4.1 Rigidity Index 1 

Rigidity index 1 (  ) is recorded in the Rigidity_Index_1 is defined as: 
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       –    

      
  –     

 –     

Mayne (2001), NCHRP Synthesis 368 pp 46 

Where: 

   is 1.5 in the published formula, and is stored in the Rigidity_Index_1_C1 field. 

   is 2.925 in the published formula, and is stored in the Rigidity_Index_1_C2 field. 

   is 2.925 in the published formula, and is stored in the Rigidity_Index_1_C3 field. 

  is the Cam clay constant, slope of the critical state line and is defined as: 

  
       

        
 

   for the calculation of the Cam clay constant   is taken from the Effective_Friction_Angle_1 field 
on the CPT_DATA table.  

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation of    is calculated only when the Soil_Type_1 field value on the CPT_DATA table has a 
value of Fine for that row. 

12.4.2 Rigidity Index 2 

Rigidity index 2 (  ) is recorded in the Rigidity_Index_2 is defined as: 

   
               

                         
 

Keaveny and Mitchel (1986), NCHRP Synthesis 368 pp 46 

Where: 

   is 0.0435 in the published formula, and is stored in the Rigidity_Index_2_C1 field. 

   is 137 in the published formula, and is stored in the Rigidity_Index_2_C2 field. 

   is 0.385 in the published formula, and is stored in the Rigidity_Index_2_C3 field. 

   is 3.2 in the published formula, and is stored in the Rigidity_Index_2_C4 field. 

   is 0.8 in the published formula, and is stored in the Rigidity_Index_2_C5 field. 

   is the Plasticity Index, and is stored in the Plasticity_Index field. 

    is taken from the Overconsolidation_Ratio_4 field on the CPT_DATA table. 

The constants are stored on CPT_POINT_PARAMETERS and CPT_GLOBAL_PARAMETERS tables. 

This correlation of    is calculated only when the Soil_Type_1 field value on the CPT_DATA table has a 
value of Fine for that row. 
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13 Creating a New Soil Behaviour Type 
Creating a new soil behaviour type involves adding data to library tables, and optionally creating Fixed 
Curve on Graph and Graph report.  As an example we will add a new SBT method titled GEO. 

1. Create the points and a graph for the new method in Excel.  Ensure there are no gaps and 
points of neighbouring zones coincide. 

 

4. DG_CPT_SOIL_CLASS_METHOD 

 

Graph 2 is optional 

5. DG_CPT_SOIL_CLASS_ZONES 
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6. DG_CPT_SOIL_CLASS_DATA 

 

7. You may now return to INPUT, set the new SBT method on the Global or Point Parameters 
tables, and calculate a CPT.  The results will now print on log reports. 

8. Optionally you can now create a SYMBOL DESIGN | Fixed Curve on Graph 
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9. Optionally now create a new graph report.  This can be most efficiently done by copying the 
pre-existing Graph report titled CPT ROBERTSON ET AL. 1986 QT VS. RF.  Use the 
command File > Copy page... and name the new report CPT GEO QT VS. RF. 

10. Now open the report properties and make the following changes 

Property New Value 

General Tab  

Description Soil behaviour type classification graph - GEO, total cone resistance (qt) versus 
friction ratio (Rf) 

Report Variable – Soil 
Class Method 

<<Let(A="GEO")>><<Get(A)>> 

Report Variable – 
Default Title 

GEO qt vs. Rf - [[PointID]] 

Data Representation Tab  

Fixed Curves Change Named Fixed Curve to: GEO QT VS. RF 

Override Line/DM Expression Tab  

Data marker Colour 
Expression 1 

Replace all Robertson et al. 1986 with GEO 

 

11. You may now move to OUTPUT and preview the report 
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14 Transfer Description and 

Consistency for Current PointID 
This command transfers a summary of the material type classification 1 to a Stratigraphy/Lithology 
table, and the calculated Relative_Density_Term_1 and Undrained_Shear_Strength_Term_1 to 
Consistency/Density table. 

The command is located in INPUT | Add-Ins > Datgel CPT Tool > Transfer Description and 
Consistency for current PointID, and can be called from child tables of POINT. 

The results of the first Soil Behaviour Type method are used.   

The order of operation is: 

1. Minimum Layer Thickness 

2. Consolidation of like layers 

3. Soil Group Thickness 

14.1 Minimum Layer Thickness 

This option can be used to exclude geotechnically insignificant layers, e.g. say the purpose of your CPT 
is for pile design, then you may wish to ignore a 30 mm clay lens within a much larger sand layer. 

If a layer thickness is less than the value in CPT_GLOBAL_PARAMETERS table Minimum_Thickness_Soil_Layer 
field, then the layer will be removed and:  

1. If the layer above is the same coarse or fine type, then the Bottom will be set to the Bottom of the 
removed layer. 

2. If the layer below is the same coarse or fine type, then the Depth will be set to the Depth of the 
removed layer. 

3. Otherwise the Bottom field for the layer above will be updated. 

The Consistency and Density transfer is not affected by the Minimum_Thickness_Soil_Layer field. 

This filter will not apply if Minimum_Thickness_Soil_Layer is blank. 

14.2 Soil Group Thickness 

If a layer is less than the value in CPT_GLOBAL_PARAMETERS table Soil_Class_Group_Thickness field, then it 
will be appended to the layer above if they are both the same coarse or fine type. 

The Consistency and Density transfer is not affected by the Soil_Class_Group_Thickness field. 

This filter will not apply if Soil_Class_Group_Thickness is blank. 
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14.3 Configuration of description and consistency summary transfer 

Before using the transfer command, first configure the custom fields and tables using the command in 
INPUT | Add-Ins > Datgel CPT Tool > Transfer Description and Consistency Configuration. 

 

1. Set field and table names using the pick lists.  Description Graphic 2 Field is not required. 

2. Click Set 

3. Close the form by clicking X button 
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15 Configuring the Design Line 
To be able to print a design line on the    and    columns on the log reports, the Design line must first 
be defined in the CPT_DESIGN_LINE and CPT_DESIGN_LINE_DATA tables. 

 

To enter data in the CPT_DESIGN_LINE_DATA table (lower screen); enter a Design Line ID in the 
CPT_DESIGN_LINE table (upper screen).  Enter a description if desired. 

Then click on the CPT_DESIGN_LINE_DATA table.  Each row represents a node (point or corner) in the 
Design Line, where the Elevation or Depth represents the vertical axis and the Cone_Resistance represents 
the horizontal axis.  The Node ID determines the order in which the nodes are drawn, as the Design Line 
is constructed by drawing a line from one node to the next. 

When the values in either the CPT_DESIGN_LINE or CPT_DESIGN_LINE_DATA tables are modified, you will 
be prompted with the following: 

 

Every row in the CPT_DATA table has a Cone_Resistance_Design_Line value, which is calculated based on 
which Design Line is assigned and the depth of the current row.  Therefore, it is necessary to 
recalculate the CPT_DATA table to reflect any changes made in these tables if an existing Design Line is 
modified.  However, if entering a new Design Line, it is unlikely the new Design Line is assigned to any 
PointIDs, so it is unnecessary to recalculate the CPT_DATA table.  

The Elevation value will always take precedence over Depth when calculating the Design Line.  If there 
are both Elevation and Depth values in this table, then only the Elevation values are used, and the Depth 
values are ignored.  Only if the entire Elevation column is left blank, the Depth values are used. 
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Once the Design Lines have been defined, they can be assigned to PointIDs in the 
CPT_POINT_PARAMETERS table or on the CPT_GLOBAL_PARAMETERS.  The two fields in this table related 
to the Design Line are Design_Line and Show_Design_Line. The Design_Line field is a pick list of the design 
Lines defined in the CPT_DESIGN_LINE Table, and the Show_Design_Line field is a check box which 
determines whether the Design Line is shown on the CPT log reports or not. The Design Line is 
represented on the CPT log reports as a thick black line. 
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16 Moving Average 
The Cone_Resistance_Moving_Average field in the CPT_DATA field is an average of    values above and 
below the given depth. The distance above and below can be configured in the 
CPT_GLOBAL_PARAMETERS table, in the field Moving_Average_Thickness. The thickness defines the depth 
range of the    values taken, where the given depth is in the middle of the range. 

For example, specifying a Moving_Average_Thickness of 1 m, the    values are taken from ±0.5m from the 
given depth. 
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17 Exclude Fines Layers 
A fines layer is defined by consecutive rows that have been classified as “fine” in the Soil_Type_1 Field. If 
the fines layer is thicker than a predetermined length, then the Exclude field is checked and records 
within a buffer distance are also have Exclude checked.  The Exclude field can be used to control what 
records print on the CPT reports. 

The minimum thickness to exclude the Fines layer can be defined in the Exclude_Fines_Layer_Thickness 
field in the CPT_GLOBAL_PARAMETERS table or the CPT_POINT_PARAMETERS table. The value in the 
CPT_POINT_PARAMETERS table takes precedence.  Likewise, the buffer thickness of the records above 
and below the fines layer to exclude can be defined in the field in the Exclude_Fines_Layer_Buffer field in 
the CPT_GLOBAL_PARAMETERS or the CPT_POINT_PARAMETERS table. 

NOTE: These fields are not in the standard CPT Tool gINT files 
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18 Dissipation Test Analysis 
Dissipation tests may be analysed using the strain path method (SPM) proposed by Houlsby and Teh 
1988.  Further, dissipation tests carried out in over consolidated soils maybe corrected using the square 
root time method as proposed in Sully et al. 1999, and short tests may be extrapolated forward to 
estimate tx. 

18.1 Procedure to analyse a dissipation test in normally 
consolidated soil 

1. Import the data as described in section 5 Data Import. 

2. Navigate to INPUT | CPT | Dissipation Test, and open the required PointID and Test Number.  
This example will use PointID „V-Diss test NC‟, which is the same as the test at 14.625 m in 

data file Probedrill_01.dis.  After import the screen will look similar to the following 

screen shot. 

 

3. Ensure the ground water depth is defined, see section 7 Groundwater.  Set 
CPT_GENERAL.Groundwater_Depth to 1.50. 

4. In this example the Pore_Pressure_Filter_Position must be set to u2. 

5. Rigidity_Index, Ir, maybe automatically looked up from CPT_DATA.Rigidity_Index_1 from the record 
with the same depth or next smaller depth, or may be manually defined by first checking the 
field Override_Rigidity_Index, Override Ir, and then entering a value.  In this example we will 
manually define 150. 

6. Initial_Pore_Pressure, ui, must be manually set, and is typically the first pore pressure reading of 
the test.  In this example we will manually define 579.6. 

7. Corrected_Initial_Pore_Pressure from back-extrapolation, uc, and Gradient_Corrected_Line, are not 
typically required for normally consolidated soils.  In this example these two fields are left 
blank. 

8. In_Situ_Pore_Pressure is automatically calculated based on the groundwater depth (described in 
section 7 Groundwater).  By checking Override_In_Situ_Pore_Pressure, the user can manually set 
u0.  In this example we will allow u0 to automatically calculate. 
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9. Degree_Dissipation defines the degree of dissipation, typically 50, or a lower value if t50 was not 
reached.  In this example we will use 50. 

10. Forward_Extraplolation_Y_Intercept and Forward_Extrapolation_Gradient can be used to define a best fit 
line to forward extrapolate to a t beyond the recorded data when the test doesn‟t reach the 
required Degree Dissipation.  In this example these two fields are left blank. 

11. Ratio_ch_to_cv is the ratio of horizontal coefficient of consolidation to vertical coefficient of 
consolidation.  In this example we will use 3. 

12. Now click the Save button, and the recalculated screen should be similar to the following 
screen shot. 

 

13. To preview the graph report, click on the bottom half of the screen and the click the Preview 
icon.  Graph!cpt diss. pore pressure vs. sqr t should already be set as the default report for this 
table.  The preview should be similar to the following figure. 
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18.2 Procedure to analyse a dissipation test in overconsolidated soil 

This example uses PointID V-Diss test OC, which corresponds with the data in file 

Geotech_AB_04.cpt and Geotech_AB_04.dpt. 

1. Follow steps 1 to 6 and 8 to 12 described above, however in this example set Ir to 200, ui to 
240.0, and Ratio ch to cv to 5. 

2. You may also like to use the minimum and maximum scale fields to control the graph report 
scale extents. 

3. As you can see in the following graph, the pore pressure first increases before decreasing.  
This is a typical Type III over consolidated response described in Sully et al 1999.  The uc and 
Gradient Corrected Line must be correctly defined (see figure 7 in Sully et al 1999).  The 
simplest procedure is to preview the Graph report cpt diss. pore pressure vs. sqr t by clicking 

on the INPUT preview button , estimate uc and the gradient, close the preview and enter the 
estimated numbers in the fields.  Repeat the procedure until you are happy with the magenta 
coloured line. 
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18.3 Procedure to use forward extrapolation 

The forward extrapolation option allow the user to define a straight line in measure pore pressure – 
square root minute space that will be used to estimate tx beyond the recorded data range.  An example 
of it use is illustrated below.   

In this example, PointID = V-Diss test NC 2, the data was recorded for only 64 seconds which 
corresponds with 5.5% degree of dissipation.  Using the forward extrapolation line we can estimate t50.   

1. Enter data in CPT_DISSIPATION_TEST_GENERAL as described in previous examples. 

2. The simplest procedure to define the Forward_Extraplolation_Y_Intercept and 
Forward_Extrapolation_Gradient fields is to preview the Graph report cpt diss. pore pressure vs. sqr t 

by clicking on the INPUT preview button , estimate y intercept and gradient, close the 
preview and enter the estimated numbers in the fields.  Repeat the procedure until you are 
happy with the orange coloured line.  An alternative is to print the same report in output and 
manually define the line on paper and then enter the values in the fields. 
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19 Reports 

19.1 Log Reports 

Table 3 - Log Reports 

Name Description 

CPT A4P CPT / Friction cone report with qc, fs and Rf 

CPT DYNAMIC 11X17L Dynamic CPT report 

CPT DYNAMIC A3L Dynamic CPT report 

CPT DYNAMIC A4P Dynamic CPT report 

CPT DYNAMIC LETP Dynamic CPT report 

CPT LETP CPT / Friction cone report with qc, fs and Rf 

CPT MATERIAL A4P CPT / Friction cone report with qc, fs, Rf and soil description 

CPT MATERIAL LETP CPT / Friction cone report with qc, fs, Rf and soil description 

CPT QC ONLY A4P CPT qc only 

CPT QC ONLY LETP CPT qc only 

CPT SOIL BEHAVIOUR TYPE 
INDEX A4P CPT report with qt, Fr, Bq Ic 1 and Ic 2 

CPT SOIL BEHAVIOUR TYPE 
INDEX LETP CPT report with qt, Fr, Bq Ic 1 and Ic 2 

CPTU A4P CPTU / Piezocone report with qt, fs or ft, u, u0, Rf and Bq 

CPTU COMPARISON A4 CPT/CPTU Comparison log using POINT.Associated_PointID 

CPTU COMPARISON LETP CPT/CPTU Comparison log using POINT.Associated_PointID 

CPTU DERIVED MATERIAL A4P CPTU / Piezocone derived report with qt, Rf, Bq and material description 

CPTU DERIVED MATERIAL LETP CPTU / Piezocone derived report with qt, Rf, Bq and material description 

CPTU LETP CPTU / Piezocone report with qt, fs or ft, u, u0, Rf and Bq 

CPTU MATERIAL A4P 
CPTU / Piezocone report with qt, fs or ft, u, u0, Rf, Bq and material 
description 

CPTU MATERIAL LETP 
CPTU / Piezocone report with qt, fs or ft, u, u0, Rf, Bq and material 
description 

CPTU MEASURED MATERIAL A4P CPTU / Piezocone measured report with qc, fs, u, u0 and material description 

CPTU MEASURED MATERIAL LETP CPTU / Piezocone measured report with qc, fs, u, u0 and material description 

CPTU NORMALISED N60 11X17L 
CPTU normalised parameters (qc, qt, Rf, Bq, Pennetration Rate, Qt, Fr), 
interpreted soil type, N60 and material description 

CPTU NORMALISED N60 A3L 
CPTU normalised parameters (qc, qt, Rf, Bq, Pennetration Rate, Qt, Fr), 
interpreted soil type, N60 and material description 

CPTU PHI 11X17L 
CPTU / Piezocone report with qt, fs or ft, uo, u2, Rf, Bq, interpreted soil type, 
Phi', material description and consistency 

CPTU PHI A3L 
CPTU / Piezocone report with qt, fs or ft, uo, u2, Rf, Bq, interpreted soil type, 
Phi', material description and consistency 

CPTU SU 11X17L 
CPTU / Piezocone report with qt, fs or ft, uo, u2, Rf, Bq, interpreted soil type, 
su, material description and consistency 

CPTU SU A3L 
CPTU / Piezocone report with qt, fs or ft, uo, u2, Rf, Bq, interpreted soil type, 
su, material description and consistency 

CPTU SU A4P CPTU / Piezocone report with qt, fs or ft, u, u0, Rf and Su. 
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CPTU SU DR 11X17L 
CPTU / Piezocone report with qc, qt, fs or ft, uo, u2, Rf, Bq, interpreted soil 
type, Dr, su, material description and consistency 

CPTU SU DR A3L 
CPTU / Piezocone report with qc, qt, fs or ft, uo, u2, Rf, Bq, interpreted soil 
type, Dr, su, material description and consistency 

CPTU SU DR CC 11X17L 
CPTU / Piezocone report with qc, qt, fs or ft, uo, u2, Rf, Bq, Dr, su, Cc, 
material description and consistency 

CPTU SU DR CC A3L 
CPTU / Piezocone report with qc, qt, fs or ft, uo, u2, Rf, Bq, Dr, su, Cc, 
material description and consistency 

CPTU SU LETP CPTU / Piezocone report with qt, fs or ft, u, u0, Rf and Su 

SCPTU ALL A4P 
SCPTU / Piezocone report with qt, fs, ub, t50 and Vs (Measured & 
Extrapolated) 

SCPTU ALL LETP 
SCPTU / Piezocone report with qt, fs, ub, t50 and Vs (Measured & 
Extrapolated) 

SCPTU CORRELATED A4P SCPTU / Piezocone report with qt, fs, ub, t50 and Vs (Correlated) 

SCPTU CORRELATED LETP SCPTU / Piezocone report with qt, fs, ub, t50 and Vs (Correlated) 

SCPTU MEASURED EXTRAP A4P 
SCPTU / Piezocone report with qt, fs, ub, t50 and Vs (Measured, 
Extrapolated & Correlated) 

SCPTU MEASURED EXTRAP LETP 
SCPTU / Piezocone report with qt, fs, ub, t50 and Vs (Measured, 
Extrapolated & Correlated) 

19.2 Fences Reports 

Table 4 - Fence Reports 

Name Description 

CPT FENCE 11X17L A3 landscape fence report with 6 plot column options and CPT classification 
colour column 

CPT FENCE A3L A3 landscape fence report with 6 plot column options and CPT classification 
colour column 

CPT FENCE A4L A4 landscape fence report with 6 plot column options and CPT classification 
colour column 

CPT FENCE A4P A4 portrait fence report with 6 plot column options and CPT classification colour 
column 

CPT FENCE LETL Letter landscape fence report with 6 plot column options and CPT classification 
colour column 

CPT FENCE LETP Letter portrait fence report with 6 plot column options and CPT classification 
colour column 

Table 5 - Fence Report Variables 

Name Default Value Notes 

Title Inferred Subsurface Section Enter fence report title 

Drawn  Person‟s initials/name 

Drawn Date  Enter date 

Checked  Person‟s initials/name 

Checked Date  Enter date 

Figure Number  Enter text. If left blank, it will default to “Figure 1”. 

Revision  Enter Revision 

Sheet  Enter Sheet 

Override Sitemap  Enter a value to override the default sitemap scale 
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Scale 

Stick CPT C 

C = Soil classification method colour (default) 

L = Legend/material graphic 

L C = Legend/ Soil classification method colour 

S = Stick/line  

Default Title  Enter default fence report title.  Shown if Title is empty. 

Column R3  Enter a parameter to display on the right side of the fence 
post, furthest from the centre of the PointID   

Width R3 (mm)  Enter the column width of the parameter.  If left blank, it will 
use the default column width defined for that parameter.  
Typical values are 10 mm for line and bar plots, 4 mm for 
text 

Column R2  Enter a parameter to display on the right side of the fence 
post 

Width R2 (mm)  Enter the column width of the parameter.  If left blank, it will 
use the default column width defined for that parameter.  
Typical values are 10 mm for line and bar plots, 4 mm for 
text 

Column R1  Enter a parameter to display on the right side of the fence 
post, closest to the centre of the PointID 

Width R1 (mm)  Enter the column width of the parameter.  If left blank, it will 
use the default column width defined for that parameter.  
Typical values are 10 mm for line and bar plots, 4 mm for 
text 

Column L1  Enter a parameter to display on the left side of the fence 
post, closest to the centre of the PointID 

Width L1 (mm)  Enter the column width of the parameter.  If left blank, it will 
use the default column width defined for that parameter.  
Typical values are 10 mm for line and bar plots, 4 mm for 
text 

Column L2  Enter a parameter to display on the left side of the fence 
post 

Width L2 (mm)  Enter the column width of the parameter.  If left blank, it will 
use the default column width defined for that parameter.  
Typical values are 10 mm for line and bar plots, 4 mm for 
text 

Column L3  Enter a parameter to display on the left side of the fence 
post, furthest from the centre of the PointID 

Width L3 (mm)  Enter the column width of the parameter.  If left blank, it will 
use the default column width defined for that parameter.  
Typical values are 10 mm for line and bar plots, 4 mm for 
text 

Legend 1  Enter a parameter to display a legend for the line, colour, 
data marker and reference text for each correlation of that 
parameter 

Legend 2  Enter a parameter to display a legend for the line, colour, 
data marker and reference text for each correlation of that 
parameter 

Legend 3  Enter a parameter to display a legend for the line, colour, 
data marker and reference text for each correlation of that 
parameter 

Legend 4  Enter a parameter to display a legend for the line, colour, 
data marker and reference text for each correlation of that 
parameter 
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19.3 Graph Reports 

Table 6 - Graph Reports 

Name Description 

BPT QB VS DEPTH A4P Ball Bearing Pressure (qb) vs. depth 

BPT QB VS DEPTH LETP Ball Bearing Pressure (qb) vs. depth 

CPT COEFF LATERAL EARTH 
PRESS DEPTH A4P 

Coefficient Lateral Earth Pressure (K0) correlations versus Depth 

CPT COEFF LATERAL EARTH 
PRESS DEPTH LETP 

Coefficient Lateral Earth Pressure (K0) correlations versus Depth 

CPT COEFF LATERAL EARTH 
PRESSURE RL A4P 

Coefficient Lateral Earth Pressure (K0) correlations versus Elevation 

CPT COEFF LATERAL EARTH 
PRESSURE RL LETP 

Coefficient Lateral Earth Pressure (K0) correlations versus Elevation 

CPT CONSTRAINED MODULUS 
DEPTH A4P 

Constrained Modulus (M) correlations versus Depth 

CPT CONSTRAINED MODULUS 
DEPTH LETP 

Constrained Modulus (M) correlations versus Depth 

CPT CONSTRAINED MODULUS 
RL A4P 

Constrained Modulus (M) correlations versus Elevation 

CPT CONSTRAINED MODULUS 
RL LETP 

Constrained Modulus (M) correlations versus Elevation 

CPT DISS. NORMALISED EX U 
VS. LIN T A4L 

Dissipation test graph of normalised excess pore pressure versus linear time, 
grouped by PointID 

CPT DISS. NORMALISED EX U 
VS. LIN T A4P 

Dissipation test graph of normalised excess pore pressure versus linear time 

CPT DISS. NORMALISED EX U 
VS. LIN T LETL 

Dissipation test graph of normalised excess pore pressure versus linear time, 
grouped by PointID 

CPT DISS. NORMALISED EX U 
VS. LIN T LETP 

Dissipation test graph of normalised excess pore pressure versus linear time 

CPT DISS. NORMALISED EX U 
VS. LOG T A4L 

Dissipation test graph of normalised excess pore pressure versus log time, 
grouped by PointID 

CPT DISS. NORMALISED EX U 
VS. LOG T A4P 

Dissipation test graph of normalised excess pore pressure versus log time 

CPT DISS. NORMALISED EX U 
VS. LOG T LETL 

Dissipation test graph of normalised excess pore pressure versus log time, 
grouped by PointID 

CPT DISS. NORMALISED EX U 
VS. LOG T LETP 

Dissipation test graph of normalised excess pore pressure versus log time 

CPT DISS. NORMALISED EX U 
VS. SQR T A4L 

Dissipation test graph of normalised excess pore pressure versus square root 
time, grouped by PointID 

CPT DISS. NORMALISED EX U 
VS. SQR T A4P 

Dissipation test graph of normalised excess pore pressure versus square root 
time 

CPT DISS. NORMALISED EX U 
VS. SQR T LETL 

Dissipation test graph of normalised excess pore pressure versus square root 
time, grouped by PointID 

CPT DISS. NORMALISED EX U 
VS. SQR T LETP 

Dissipation test graph of normalised excess pore pressure versus square root 
time 

CPT DISS. PORE PRESSURE VS. 
LIN T A4L 

Dissipation test graph of normalised excess pore pressure versus linear time, 
grouped by PointID 

CPT DISS. PORE PRESSURE VS. 
LIN T A4P 

Dissipation test graph of pore pressure versus linear time 

CPT DISS. PORE PRESSURE VS. Dissipation test graph of normalised excess pore pressure versus linear time, 
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LIN T LETL grouped by PointID 

CPT DISS. PORE PRESSURE VS. 
LIN T LETP 

Dissipation test graph of pore pressure versus linear time 

CPT DISS. PORE PRESSURE VS. 
LOG T A4L 

Dissipation test graph of normalised excess pore pressure versus log time, 
grouped by PointID 

CPT DISS. PORE PRESSURE VS. 
LOG T A4P 

Dissipation test graph of pore pressure versus log time 

CPT DISS. PORE PRESSURE VS. 
LOG T LETL 

Dissipation test graph of normalised excess pore pressure versus log time, 
grouped by PointID 

CPT DISS. PORE PRESSURE VS. 
LOG T LETP 

Dissipation test graph of pore pressure versus log time 

CPT DISS. PORE PRESSURE VS. 
SQR T A4L 

Dissipation test graph of normalised excess pore pressure versus square root 
time, grouped by PointID 

CPT DISS. PORE PRESSURE VS. 
SQR T A4P 

Dissipation test graph of pore pressure versus square root time 

CPT DISS. PORE PRESSURE VS. 
SQR T LETL 

Dissipation test graph of normalised excess pore pressure versus square root 
time, grouped by PointID 

CPT DISS. PORE PRESSURE VS. 
SQR T LETP 

Dissipation test graph of pore pressure versus square root time 

CPT EFFECTIVE COHESION 
DEPTH A4P 

Effective Cohesion (c') correlations versus Depth 

CPT EFFECTIVE COHESION 
DEPTH LETP 

Effective Cohesion (c') correlations versus Depth 

CPT EFFECTIVE COHESION RL 
A4P 

Effective Cohesion (c') correlations versus Elevation 

CPT EFFECTIVE COHESION RL 
LETP 

Effective Cohesion (c') correlations versus Elevation 

CPT EFFECTIVE FRICTION 
ANGLE DEPTH A4P 

Effective Friction Angle (Phi') correlations versus Depth 

CPT EFFECTIVE FRICTION 
ANGLE DEPTH LETP 

Effective Friction Angle (Phi') correlations versus Depth 

CPT EFFECTIVE FRICTION 
ANGLE RL A4P 

Effective Friction Angle (Phi') correlations versus Elevation 

CPT EFFECTIVE FRICTION 
ANGLE RL LETP 

Effective Friction Angle (Phi') correlations versus Elevation 

CPT IC 1 DEPTH A4P Soil Behaviour Type Index (Ic) 1 versus Depth 

CPT IC 1 DEPTH LETP Soil Behaviour Type Index (Ic) 1 versus Depth 

CPT IC 1 RL A4P Soil Behaviour Type Index (Ic) 1 versus Elevation 

CPT IC 1 RL COLOUR A4P Soil Behaviour Type Index (Ic) 1 versus Elevation with differing colours for each 
PointID 

CPT IC 1 RL COLOUR LETP Soil Behaviour Type Index (Ic) 1 versus Elevation with differing colours for each 
PointID 

CPT IC 1 RL LETP Soil Behaviour Type Index (Ic) 1 versus Elevation 

CPT IC 2 DEPTH A4P Soil Behaviour Type Index (Ic) 2 versus Depth 

CPT IC 2 DEPTH LETP Soil Behaviour Type Index (Ic) 2 versus Depth 

CPT IC 2 RL A4P Soil Behaviour Type Index (Ic) 2 versus Elevation 

CPT IC 2 RL COLOUR A4P Soil Behaviour Type Index (Ic) 2 versus Elevation with differing colours for each 
PointID 

CPT IC 2 RL COLOUR LETP Soil Behaviour Type Index (Ic) 2 versus Elevation with differing colours for each 
PointID 
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CPT IC 2 RL LETP Soil Behaviour Type Index (Ic) 2 versus Elevation 

CPT OCR DEPTH A4P Overconsolidation Ratio (OCR) correlations versus Depth 

CPT OCR DEPTH LETP Overconsolidation Ratio (OCR) correlations versus Depth 

CPT OCR RL A4P Overconsolidation Ratio (OCR) correlations versus Elevation 

CPT OCR RL LETP Overconsolidation Ratio (OCR) correlations versus Elevation 

CPT PRECONSOLIDATION 
STRESS DEPTH A4P 

Preconsolidation Stress (Sig p') correlations versus Depth 

CPT PRECONSOLIDATION 
STRESS DEPTH LETP 

Preconsolidation Stress (Sig p') correlations versus Depth 

CPT PRECONSOLIDATION 
STRESS RL A4P 

Preconsolidation Stress (Sig p') correlations versus Elevation 

CPT PRECONSOLIDATION 
STRESS RL LETP 

Preconsolidation Stress (Sig p') correlations versus Elevation 

CPT QC QT VS DEPTH A4P Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Depth. If qt 
is found, the graph will plot qt. Otherwise, qc is plotted 

CPT QC QT VS DEPTH COLOUR 
A4P 

Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Depth with 
differing colours for each PointID. If qt is found, the graph will plot qt. Otherwise, 
qc is plotted 

CPT QC QT VS DEPTH COLOUR 
LETP 

Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Depth with 
differing colours for each PointID. If qt is found, the graph will plot qt. Otherwise, 
qc is plotted 

CPT QC QT VS DEPTH FT PSI 
A4P 

Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Depth. If qt 
is found, the graph will plot qt. Otherwise, qc is plotted.  Two scales on each axis, 
m and ft, and MPa and psi 

CPT QC QT VS DEPTH FT PSI 
LETP 

Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Depth. If qt 
is found, the graph will plot qt. Otherwise, qc is plotted.  Two scales on each axis, 
m and ft, and MPa and psi 

CPT QC QT VS DEPTH LETP Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Depth. If qt 
is found, the graph will plot qt. Otherwise, qc is plotted 

CPT QC QT VS ELEVATION A4P Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Elevation. If 
qt is found, the graph will plot qt. Otherwise, qc is plotted 

CPT QC QT VS ELEVATION 
COLOUR A4P 

Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Elevation 
with differing colours for each pointID. If qt is found, the graph will plot qt. 
Otherwise, qc is plotted 

CPT QC QT VS ELEVATION 
COLOUR LETP 

Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Elevation 
with differing colours for each pointID. If qt is found, the graph will plot qt. 
Otherwise, qc is plotted 

CPT QC QT VS ELEVATION LETP Cone Resistance (qc) or Corrected Total Cone Resistance (qt) versus Elevation. If 
qt is found, the graph will plot qt. Otherwise, qc is plotted 

CPT RELATIVE DENSITY DEPTH 
A4P 

Relative Density (Dr) correlations versus Depth 

CPT RELATIVE DENSITY DEPTH 
LETP 

Relative Density (Dr) correlations versus Depth 

CPT RELATIVE DENSITY RL A4P Relative Density (Dr) correlations versus Elevation 

CPT RELATIVE DENSITY RL 
LETP 

Relative Density (Dr) correlations versus Elevation 

CPT RF VS DEPTH A4P Friction ratio (Rf) vs depth 

CPT RF VS DEPTH LETP Friction ratio (Rf) vs depth 

CPT RF VS ELEVATION A4P Friction Ratio (Rf) versus Elevation 

CPT RF VS ELEVATION COLOUR 
A4P 

Friction ratio (Rf) vs elevation with differing colours for each PointID 
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CPT RF VS ELEVATION COLOUR 
LETP 

Friction ratio (Rf) vs elevation with differing colours for each PointID 

CPT RF VS ELEVATION LETP Friction Ratio (Rf) versus Elevation 

CPT RIGIDITY INDEX DEPTH A4P Rigidity Index (Ir) correlations versus Depth 

CPT RIGIDITY INDEX DEPTH 
LETP 

Rigidity Index (Ir) correlations versus Depth 

CPT RIGIDITY INDEX RL A4P Rigidity Index (Ir) correlations versus Elevation 

CPT RIGIDITY INDEX RL LETP Rigidity Index (Ir) correlations versus Elevation 

CPT ROBERTSON 90 QT VS. BQ 
A4P 

Soil behaviour type classification graph - Robertson 1990, normalised cone 
resistance (Qt) versus pore pressure parameter (Bq) 

CPT ROBERTSON 90 QT VS. BQ 
EXTRAP A4P 

Soil behaviour type classification graph - Robertson 1990 (extrapolated graph), 
normalised cone resistance (Qt) versus pore pressure parameter (Bq) 

CPT ROBERTSON 90 QT VS. BQ 
EXTRAP LETP 

Soil behaviour type classification graph - Robertson 1990 (extrapolated graph), 
normalised cone resistance (Qt) versus pore pressure parameter (Bq) 

CPT ROBERTSON 90 QT VS. BQ 
EXTRAP M A4P 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
1990 (extrapolated graph), normalised cone resistance (Qt) versus pore pressure 
parameter (Bq) 

CPT ROBERTSON 90 QT VS. BQ 
EXTRAP M LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
1990 (extrapolated graph), normalised cone resistance (Qt) versus pore pressure 
parameter (Bq) 

CPT ROBERTSON 90 QT VS. BQ 
LETP 

Soil behaviour type classification graph - Robertson 1990, normalised cone 
resistance (Qt) versus pore pressure parameter (Bq) 

CPT ROBERTSON 90 QT VS. BQ 
M A4P 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
1990, normalised cone resistance (Qt) versus pore pressure parameter (Bq) 

CPT ROBERTSON 90 QT VS. BQ 
M LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
1990, normalised cone resistance (Qt) versus pore pressure parameter (Bq) 

CPT ROBERTSON 90 QT VS. FR 
A4P 

Soil behaviour type classification graph - Robertson 1990, normalised cone 
resistance (Qt) versus normalised friction ration (Fr) 

CPT ROBERTSON 90 QT VS. FR 
EXTRAP A4P 

Soil behaviour type classification graph - Robertson 1990 (extrapolated graph), 
normalised cone resistance (Qt) versus normalised friction ration (Fr) 

CPT ROBERTSON 90 QT VS. FR 
EXTRAP LETP 

Soil behaviour type classification graph - Robertson 1990 (extrapolated graph), 
normalised cone resistance (Qt) versus normalised friction ration (Fr) 

CPT ROBERTSON 90 QT VS. FR 
EXTRAP M A4P 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
1990 (extrapolated graph), normalised cone resistance (Qt) versus normalised 
friction ration (Fr) 

CPT ROBERTSON 90 QT VS. FR 
EXTRAP M LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
1990 (extrapolated graph), normalised cone resistance (Qt) versus normalised 
friction ration (Fr) 

CPT ROBERTSON 90 QT VS. FR 
LETP 

Soil behaviour type classification graph - Robertson 1990, normalised cone 
resistance (Qt) versus normalised friction ration (Fr) 

CPT ROBERTSON 90 QT VS. FR 
M  A4P 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
1990, normalised cone resistance (Qt) versus normalised friction ration (Fr) 

CPT ROBERTSON 90 QT VS. FR 
M  LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
1990, normalised cone resistance (Qt) versus normalised friction ration (Fr) 

CPT ROBERTSON ET AL. 86 QC 
VS. RF A4P 

Soil behaviour type classification graph - Robertson et. al. 1986, cone resistance 
(qc) versus friction ratio (Rf) 

CPT ROBERTSON ET AL. 86 QC 
VS. RF LETP 

Soil behaviour type classification graph - Robertson et. al. 1986, cone resistance 
(qc) versus friction ratio (Rf) 

CPT ROBERTSON ET AL. 86 QC 
VS. RF M A4P 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
et. al. 1986, cone resistance (qc) versus friction ratio (Rf) 

CPT ROBERTSON ET AL. 86 QC 
VS. RF M LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
et. al. 1986, cone resistance (qc) versus friction ratio (Rf) 
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CPT ROBERTSON ET AL. 86 QT 
VS. BQ A4P 

Soil behaviour type classification graph - Robertson et. al. 1986, total corrected 
cone resistance (qt) versus pore pressure parameter (Bq) 

CPT ROBERTSON ET AL. 86 QT 
VS. BQ LETP 

Soil behaviour type classification graph - Robertson et. al. 1986, total corrected 
cone resistance (qt) versus pore pressure parameter (Bq) 

CPT ROBERTSON ET AL. 86 QT 
VS. BQ M A4P 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
et. al. 1986, total corrected cone resistance (qt) versus pore pressure parameter 
(Bq) 

CPT ROBERTSON ET AL. 86 QT 
VS. BQ M LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
et. al. 1986, total corrected cone resistance (qt) versus pore pressure parameter 
(Bq) 

CPT ROBERTSON ET AL. 86 QT 
VS. RF A4P 

Soil behaviour type classification graph - Robertson et. al. 1986, total corrected 
cone resistance (qt) versus friction ratio (Rf) 

CPT ROBERTSON ET AL. 86 QT 
VS. RF LETP 

Soil behaviour type classification graph - Robertson et. al. 1986, total corrected 
cone resistance (qt) versus friction ratio (Rf) 

CPT ROBERTSON ET AL. 86 QT 
VS. RF M A4P 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
et. al. 1986, total corrected cone resistance (qt) versus friction ratio (Rf) 

CPT ROBERTSON ET AL. 86 QT 
VS. RF M LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Robertson 
et. al. 1986, total corrected cone resistance (qt) versus friction ratio (Rf) 

CPT SCHNEIDER ET AL. 08  LOG-
LOG A4P 

Soil behaviour type classification graph - Schneider et al 2008, normalised cone 
resistance (Qt) versus normalised pore pressure parameter (Delta u2 / Sigma'v0). 
Log-Log plot for use with clays, clayey silts, silts, sandy silts and sands with no 
negative penetration pore pressures 

CPT SCHNEIDER ET AL. 08  LOG-
LOG LETP 

Soil behaviour type classification graph - Schneider et al 2008, normalised cone 
resistance (Qt) versus normalised pore pressure parameter (Delta u2 / Sigma'v0). 
Log-Log plot for use with clays, clayey silts, silts, sandy silts and sands with no 
negative penetration pore pressures 

CPT SCHNEIDER ET AL. 08  LOG-
LOG M A4P 

Soil behaviour type classification graph - Multiple PointIDs per page - Schneider 
et al 2008, normalised cone resistance (Qt) versus normalised pore pressure 
parameter (Delta u2 / Sigma'v0). Log-Log plot for use with clays, clayey silts, silts, 
sandy silts and sands with no negative penetration pore pressures 

CPT SCHNEIDER ET AL. 08  LOG-
LOG M LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Schneider 
et al 2008, normalised cone resistance (Qt) versus normalised pore pressure 
parameter (Delta u2 / Sigma'v0). Log-Log plot for use with clays, clayey silts, silts, 
sandy silts and sands with no negative penetration pore pressures 

CPT SCHNEIDER ET AL. 08 QT 
VS. BQ A4P 

Soil behaviour type classification graph - Schneider et al 2008, normalised cone 
resistance (Qt) versus pore pressure parameter (Bq). Semilog plot for use with 
clay soils with large negative excess penetration pore pressures 

CPT SCHNEIDER ET AL. 08 QT 
VS. BQ LETP 

Soil behaviour type classification graph - Schneider et al 2008, normalised cone 
resistance (Qt) versus pore pressure parameter (Bq). Semilog plot for use with 
clay soils with large negative excess penetration pore pressures 

CPT SCHNEIDER ET AL. 08 QT 
VS. BQ M A4P 

Soil behaviour type classification graph - Multiple PointIDs per page - Schneider 
et al 2008, normalised cone resistance (Qt) versus pore pressure parameter (Bq). 
Semilog plot for use with clay soils with large negative excess penetration pore 
pressures 

CPT SCHNEIDER ET AL. 08 QT 
VS. BQ M LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Schneider 
et al 2008, normalised cone resistance (Qt) versus pore pressure parameter (Bq). 
Semilog plot for use with clay soils with large negative excess penetration pore 
pressures 

CPT SCHNEIDER ET AL. 08 
SEMI-LOG A4P 

Soil behaviour type classification graph - Schneider et al 2008, normalised cone 
resistance (Qt) versus normalised pore pressure parameter (Delta u2 / Sigma'v0). 
Semilog plot for use with sands and transitional soils with small negative excess 
penetration pore pressures 

CPT SCHNEIDER ET AL. 08 
SEMI-LOG LETP 

Soil behaviour type classification graph - Schneider et al 2008, normalised cone 
resistance (Qt) versus normalised pore pressure parameter (Delta u2 / Sigma'v0). 
Semilog plot for use with sands and transitional soils with small negative excess 
penetration pore pressures 

CPT SCHNEIDER ET AL. 08 Soil behaviour type classification graph - Multiple PointIDs per page - Schneider 
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SEMI-LOG M A4P et al 2008, normalised cone resistance (Qt) versus normalised pore pressure 
parameter (Delta u2 / Sigma'v0). Semilog plot for use with sands and transitional 
soils with small negative excess penetration pore pressures 

CPT SCHNEIDER ET AL. 08 
SEMI-LOG M LETP 

Soil behaviour type classification graph - Multiple PointIDs per page - Schneider 
et al 2008, normalised cone resistance (Qt) versus normalised pore pressure 
parameter (Delta u2 / Sigma'v0). Semilog plot for use with sands and transitional 
soils with small negative excess penetration pore pressures 

CPT SENSITIVITY DEPTH A4P Sensitivity (St) correlations versus Depth 

CPT SENSITIVITY DEPTH LETP Sensitivity (St) correlations versus Depth 

CPT SENSITIVITY RL A4P Sensitivity (St) correlations versus Elevation 

CPT SENSITIVITY RL LETP Sensitivity (St) correlations versus Elevation 

CPT SHEAR WAVE VELOCITY 
DEPTH A4P 

Shear Wave Velocity (Vs) correlations and measured versus Depth 

CPT SHEAR WAVE VELOCITY 
DEPTH LETP 

Shear Wave Velocity (Vs) correlations and measured versus Depth 

CPT SHEAR WAVE VELOCITY RL 
A4P 

Shear Wave Velocity (Vs) correlations versus Elevation 

CPT SHEAR WAVE VELOCITY RL 
LETP 

Shear Wave Velocity (Vs) correlations versus Elevation 

CPT SMALL STRAIN SHEAR MOD 
DEPTH A4P 

Small Strain Shear Modulus (G0 or Gmax) correlations versus Depth 

CPT SMALL STRAIN SHEAR MOD 
DEPTH LETP 

Small Strain Shear Modulus (G0 or Gmax) correlations versus Depth 

CPT SMALL STRAIN SHEAR 
MODULUS RL A4P 

Small Strain Shear Modulus (Go or Gmax) correlations versus Elevation 

CPT SMALL STRAIN SHEAR 
MODULUS RL LETP 

Small Strain Shear Modulus (Go or Gmax) correlations versus Elevation 

CPT SPT N60 DEPTH A4P SPT N60 correlations versus Depth 

CPT SPT N60 DEPTH LETP SPT N60 correlations versus Depth 

CPT SPT N60 RL A4P SPT N60 correlations versus Elevation 

CPT SPT N60 RL LETP SPT N60 correlations versus Elevation 

CPT SU VS DEPTH VANE TV PP 
A4P 

Undrained shear strength vs depth. Plots Su from CPT, in situ vane, in situ 
torvane, in situ pocket penetrometer.  Each test type to have different data marker 
and CPT to have a line (no data marker) 

CPT SU VS DEPTH VANE TV PP 
LETP 

Undrained shear strength vs depth. Plots Su from CPT, in situ vane, in situ 
torvane, in situ pocket penetrometer.  Each test type to have different data marker 
and CPT to have a line (no data marker) 

CPT UNDRAINED SHEAR 
STRENGTH DEPTH A4P 

Undrained Shear Strength (Su) correlations versus Depth 

CPT UNDRAINED SHEAR 
STRENGTH DEPTH LETP 

Undrained Shear Strength (Su) correlations versus Depth 

CPT UNDRAINED SHEAR 
STRENGTH RL A4P 

Undrained Shear Strength (Su) correlations versus Elevation 

CPT UNDRAINED SHEAR 
STRENGTH RL LETP 

Undrained Shear Strength (Su) correlations versus Elevation 

CPT YOUNGS MODULUS DEPTH 
A4P 

Youngs Modulus (E) correlations versus Depth 

CPT YOUNGS MODULUS DEPTH 
LETP 

Youngs Modulus (E) correlations versus Depth 

CPT YOUNGS MODULUS RL A4P Youngs Modulus (E) correlations versus Elevation 

CPT YOUNGS MODULUS RL Youngs Modulus (E) correlations versus Elevation 
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